
Forte Tutorials

Release 18.2ANSYS, Inc.
August 2017Southpointe

2600 ANSYS Drive
Canonsburg, PA 15317 ANSYS, Inc. and

ANSYS Europe,ansysinfo@ansys.com
Ltd. are UL

http://www.ansys.com registered ISO
(T) 724-746-3304
(F) 724-514-9494

9001: 2008
companies.



Copyright and Trademark Information

© 2017 ANSYS, Inc. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, AUTODYN, CFX, FLUENT and any and all ANSYS, Inc. brand, product, service and feature
names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries located in the
United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark
of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property
of their respective owners. FLEXlm and FLEXnet are trademarks of Flexera Software LLC.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFID-
ENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products
and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement
that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting
laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products
and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions
of that software license agreement.

ANSYS, Inc. and ANSYS Europe, Ltd. are UL registered ISO 9001: 2008 companies.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use,
duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc.
software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software
and third-party software. If you are unable to access the Legal Notice, contact ANSYS, Inc.

Published in the U.S.A.



Table of Contents

1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
2. Simulating a Diesel Engine Using a Sector Mesh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
2.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.2. Generating the Sector Mesh .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
2.2.1. Define the Engine Parameters ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
2.2.2. Select the Mesh Topology .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.2.3. Specify the Mesh-Size Parameters ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.2.4. Generate the Mesh and Review .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.2.5. Import the Mesh into the Open Forte Project ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.2.6. Set Up the Case .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.2.6.1. Run the Case Using Defaults ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.2.6.2. Problem Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

2.3. Reference .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3. Simulating Dual Fuel Combustion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
3.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

3.2. Pre-Processing the Chemistry Set ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.3. Importing the Mesh .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.3.1. Set Up the Case .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.3.1.1. Save the Project ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.3.1.2. Run the Case Using Defaults ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.3.1.3. Visualizing the Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3.4. Reference .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
4. Spray Bomb Modeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

4.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
4.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
4.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
4.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

4.2. Modeling Solid-Cone Spray Injection .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
4.2.1. Spray Bomb ..... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

4.2.1.1. Problem Description .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
4.2.1.2. Mesh Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
4.2.1.3. Models Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

4.2.1.3.1. Boundary Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.2.1.3.2. Initial Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
4.2.1.3.3. Parameter Study on Pressure .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.1.3.4. Simulation Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.1.3.5. Chemistry Solver ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
4.2.1.3.6. Transport Terms .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

4.2.1.4. Output Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
4.2.1.5. Save Project ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
4.2.1.6. Run Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
4.2.1.7. Run Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
4.2.1.8. Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

4.3. Reference .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

iii
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



5. Port-Injected Spark Ignition Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

5.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
5.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

5.2. Port-Injected Spark Ignition Engine .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.2.1. Problem Description .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

5.2.1.1. Import the Geometry .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
5.2.1.2. Subvolume Creation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
5.2.1.3. Automatic Mesh Generation Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
5.2.1.4. Models Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
5.2.1.5. Boundary Conditions: ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
5.2.1.6. Initialization .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
5.2.1.7. Simulation Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
5.2.1.8. Output Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
5.2.1.9. Preview Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
5.2.1.10. Run Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
5.2.1.11. Run Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

5.2.2. Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
6. Tracking Soot Particles Evolution in a Diesel Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

6.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
6.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
6.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
6.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
6.1.4. Prerequisites for This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

6.2. Project Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
6.2.1. Sector Mesh Details ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
6.2.2. Chemistry Set Details ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
6.2.3. Transport Property Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
6.2.4. Spray Model Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
6.2.5. Soot Model Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
6.2.6. Boundary Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
6.2.7. Initial Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
6.2.8. Simulation Control ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
6.2.9. Output Control ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

6.3. Project Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
7. Solving a Gasoline Direct Injection Engine Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

7.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
7.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
7.1.4. Prerequisites for This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

7.2. Direct Injection Spark Ignition Engine .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
7.2.1. Problem Description .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

7.2.1.1. Import the Geometry .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
7.2.1.2. Subvolume Creation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
7.2.1.3. Automatic Mesh Generation Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
7.2.1.4. Models Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
7.2.1.5. Boundary Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
7.2.1.6. Initialization .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
7.2.1.7. Simulation Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
7.2.1.8. Output Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.iv

Tutorials



7.2.1.9. Preview Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
7.2.1.10. Run Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
7.2.1.11. Run Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

7.2.2. Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
8. Two-Stroke Engine Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

8.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
8.1.1. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
8.1.2. Project Comparison Utility ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
8.1.3. Time Estimate .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
8.1.4. Prerequisites for This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

8.2. Two-Stroke Marine Engine Project Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
8.2.1. Problem Description .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

8.2.1.1. Two-Stroke Engine Details ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
8.2.1.2. Automatic Mesh Generation Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

8.2.2. Chemistry Set Details ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
8.2.3. Transport Property Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
8.2.4. Spray Model Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
8.2.5. Boundary Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
8.2.6. Initial Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99
8.2.7. Simulation Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
8.2.8. Output Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
8.2.9. Preview Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
8.2.10. Run Settings .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
8.2.11. Run Simulation .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

8.3. Project Results ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
9. Multi-Cylinder Four-Stroke Engine Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

9.1. Data Provided .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
9.1.1. Accessing Tutorial Files ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
9.1.2. Files Used in This Tutorial ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111

9.2. Engine Configuration and Problem Description .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
9.3. Multi-Cylinder Spark-Ignition Engine Project Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

9.3.1. Geometry Import ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
9.3.2. Defining Reference Frames and Time Frames .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

9.3.2.1. Reference Frames .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
9.3.2.2. Time Frames .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

9.3.3. Automatic Mesh Generation Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
9.3.4. Model Setup .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
9.3.5. Boundary Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
9.3.6. Initial Conditions .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
9.3.7. Simulation Controls ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

9.4. Result Visualization .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

v
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Tutorials



Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.vi



Chapter 1: Introduction

The ANSYS Forte CFD™ software is designed for 3-D, multi-phase engine simulations with combustion.
This manual consists of tutorials that illustrate how to use ANSYS Forte CFD to address a variety of engine
designs including compression ignition and spark ignition. The tutorials generally represent realistic
situations that might be encountered by practicing scientists or engineers. They have been chosen to
demonstrate the wide range of software capabilities, and the different ways ANSYS Forte can be used.

In this manual, we address two major categories of engine simulations: Diesel modeling with sector
mesh generation is covered in Simulating a Diesel Engine Using a Sector Mesh (p. 3), modeling of
Dual Fuels is covered in Simulating Dual Fuel Combustion (p. 15), Evaporating Spray modeling is covered
in Spray Bomb Modeling (p. 27), and Spark Ignition modeling with moving valves, and automatic mesh
generation in Port-Injected Spark Ignition Engine (p. 41). Soot particle tracking is demonstrated in
Tracking Soot Particles Evolution in a Diesel Engine (p. 57). In Solving a Gasoline Direct Injection Engine
Simulation (p. 67), gasoline direct injection in an SI engine is modeled. In Two-Stroke Engine Simula-
tion (p. 89), a two-stroke marine engine with intake and exhaust ports is described. This lesson also
includes a restart file, pressure profiles, plus an .stl file, to try starting from only the geometry.

Note

Before working with these tutorials, we recommend that you first review the Forte Quick
Start Guide to become familiar with the operation of the ANSYS Forte interface and how to
set up, run, and visualize results.
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Chapter 2: Simulating a Diesel Engine Using a Sector Mesh

For diesel engines, the engine combustion is often simulated from intake valve closure (IVC) to exhaust
valve opening (EVO), rather than modeling the full air intake or exhaust flow processes involving the
intake and exhaust ports, respectively. This is usually a reasonable approximation since the gas in the
cylinder at IVC is a relatively homogeneous mixture of air and exhaust gas (due to internal residual or
from exhaust-gas recycling), prior to fuel injection. Furthermore, the nozzle hole pattern of the fuel in-
jection usually gives rise to a periodic symmetry, based on the number of nozzle holes. In this tutorial
we describe the use of a sector mesh that takes advantage of such symmetry for simulating a diesel
engine operating in low-temperature-combustion (LTC) mode. The LTC mode involves an early injection
timing, relative to more conventional diesel operation.

A sector can represent the full geometry, since we can take advantage of the periodicity of the cylinder
and injector nozzle-hole pattern. For example, an eight-hole injector allows simulation using a 45° sector
(360/8). By using the symmetry of the problem in this way, the mesh created is much smaller and the
simulation therefore runs faster than it would with a 360° mesh. Such a simplification usually cannot
be made for spark-ignited engine cases due to asymmetries introduced by spark plugs, piston shape,
and possibly intake ports.

2.1. Data Provided

2.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and access the Forte  tutorial files to download. The files for this tutorial include:

• sandia_bowl_profile.csv:  Data describing the piston bowl shape. This profile can be imported or manually
entered in the Profile Editor for use by the Sector Mesh Generator to define the bowl shape.

• InjectionProfile.csv:  Data describing the spray injection. The data can be imported from this file through
the User Interface or manually entered once you reach the Spray node on the Workflow tree through use
of the Profile Editor.

• UserCrankAngleOutputs.csv: Table of data that contains crank angles going from -22 to +20.

• Sandia_Engine_LTC_EarlyInj.ftsim:  A project file of the completed tutorial, for verification or comparison
of your progress in the tutorial set-up.

The sample files are provided as a download. You have the opportunity to select the location for the
files when you download and uncompress the sample files.

2.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
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provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your favorite diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.

2.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take 19 minutes on a dual Intel®

Xeon® processor E5-2690 at 2.90 GHz (8 total cores).

2.2. Generating the Sector Mesh

The Forte Sector Mesh Generator provides six different sample mesh topologies for different piston
bowl shapes. The shape of the piston bowl determines which mesh topology is most appropriate. The
overview of the process is:

1. Specify the bowl profile.

2. Enter engine parameters, such as bore, stroke, etc.

3. Select a topology for meshing.

4. Specify the control point locations for the mesh topology if necessary (for Topology 3, these are assumed
and the profile must have exactly 3 points to define them).

5. Specify the number of cells between control points for the mesh.

6. Generate the mesh and import into Forte.

Note

All Editor panel options that are not explicitly mentioned in this tutorial should be left at
their default values. Changed values on any Editor panel do not take effect until you press
the Apply button.

2.2.1. Define the Engine Parameters

1. To begin creating a sector mesh, go to the Workflow tree and click Geometry. This opens the Geometry

icon bar. Click the Launch Sector Mesh Generator  icon to open the Sector Mesh Generator Utility
(SMG).

2. Start by clicking the Engine Parameters node in the SMG Project tree to open an Editor panel.

3. In that panel, the first step is to import the simple bowl profile that was provided with the sample. To do

this, go to the Bowl Profile pull-down menu and select Create New... and click the Pencil  icon. This
opens the Profile Editor window.
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4. In the Profile Editor, click the Load CSV button (you may need to expand the window vertically to see the
button below the table) and then browse to, select, and open the sandia_bowl_profile.csv  file. In the
dialog, select Comma as the Column Delimiter and uncheck (turn OFF) the Read Column Titles box and
click OK.

5. In the .csv  file, the first column is the X-coordinate and the second column is the Z-coordinate. For this
example the “bowl” is completely flat and the wall of the bowl is vertical. For this very simple geometry,
only three coordinate points are needed to define the bowl. The profile should look like a flat line in the
Profile Editor display, as shown in Figure 1.12: Diesel sector sample case . At the bottom of the Profile Editor
panel in the text entry field under Profile Name, enter a name for the profile, such as “Sandia Bowl Profile”.
See Figure 1.11: Sector Mesh Generator Utility with new Profile and Editor panel . Click Save.

Figure 2.1:  Sector Mesh Generator Utility with New Profile and Editor panel

6. Next, in the Sector Mesh Generator, specify the engine parameters, which are:

• Sector Angle = 45 degrees

• Bore = 13.97 cm

• Stroke = 15.24 cm

• Squish = 0.56 cm

• Crevice Width = 0.167 cm

• Select and expand the Include Crevice Block option and set Crevice Height = 3.72621 cm. Click Apply.
A diagram preview of the engine geometry appears.

2.2.2. Select the Mesh Topology

Once you have a profile, the first step in the mesh workflow is to specify the desired mesh topology
that is appropriate for the imported piston-bowl shape. For this simple flat-piston-bowl geometry, To-
pology 3 will be used since it is a square-shaped bowl, as shown in Figure 1.9: Template for Topology
#3 . For this topology there are only 3 coordinates needed to define the profile and exactly 3 are required.
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Figure 2.2: Template for Topology #3

1. Now go to the Mesh Parameters node in the SMG tree. Select Topology 3 in the Topology pull-down
menu. If you would like to see the topology template selected, click the Show Topology button. It should
look like that shown in Figure 1.9: Template for Topology #3 .

2.2.3. Specify the Mesh-Size Parameters

Next, enter the cell counts between the different control points, as indicated in the Topology #3 diagram,
and in the schematic drawing in the 3-D display window. The parameters we will enter are as follows:

• Circumferential Cell Count = 21

• Radial Cell Count i1 = 16

• Radial Cell Count i2 = 11

• Radial Cell Count i3 = 3

• Axial Cell Count k1 = 11

• Axial Cell Count k4 = 21

• Axial Cell Count k5 = 11

• Smoothing Passes = 20 (default value; works well for most cases)

2.2.4. Generate the Mesh and Review

1. Once all the settings are specified, click Apply. Review the outline of the profile information in the 3-D
View panel to verify that the settings make sense.

2. Then use the Generate a Mesh  icon at the top of the Mesh Parameters Editor panel in the Sector Mesh
Generator. ANSYS Forte will automatically generate the sector mesh. When it is finished, the resulting mesh
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will appear for your review in the 3-D View window within the Sector Mesh Generator window, as shown

in Figure 1.12: Diesel sector sample case . (You may need to click the Refit  icon.)

Note

You can modify settings here to refine or coarsen the mesh, for example, and re-generate,
or you can open (import) the newly created mesh into the sample project into Forte. Altern-
atively, you can use the Save to File button to export to a mesh file that can later be imported
into ANSYS Forte.

2.2.5. Import the Mesh into the Open Forte Project

1. For this tutorial, click the Import to Forte Project  icon in the icon bar at the top of the SMG panel.
Now you can go to the Simulate window and see the mesh that you just generated displayed in the main

3-D View panel. To center and resize the mesh display, click the Refit  icon on the toolbar.

Figure 2.3:  Diesel sector sample mesh as generated in the Sector Mesh Generator.

2. If the Sector Mesh Generator window is still open, you can close it.

2.2.6. Set Up the Case

Now that the mesh has been defined, you can set up the models and solver options using the guided
tasks in the Forte Simulate Workflow tree. In many cases, default parameters are assumed and employed,
such that no input is required. The required inputs and changes to the setup panels for this case are
described here.
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In the Workflow tree, expand Models. In the following steps you will turn ON (check-mark) several
models and configure parameters for them in their Editor panels.

Note

You can change the display properties of items in the 3-D View by selecting the items in the
Visibility tree and turning ON/OFF their visibility or right-clicking and selecting options from
the context menu, such as display of the mesh or level of opacity.

1. Models > Chemistry: In the Workflow tree, under Models, select Chemistry. On the Chemistry icon bar, click

the Import Chemistry  icon. This opens a file browser where you can navigate to and select a chemistry
set file. For this project, however, we use a pre-installed chemistry set that comes with ANSYS Forte. This
is a simplified, reduced n-heptane mechanism that can be used to represent the diesel fuel under conven-
tional diesel-engine combustion conditions. To load this file, browse to the System Data  directory and
locate the pre-installed Diesel_1comp_35sp.cks  file. The System Data  directory can be accessed from
this file browser by clicking the data radio button in the upper right-hand sub-panel of the browser window.
The chemistry file is a standard CHEMKIN chemistry-set file. More information about the chemistry set and
the files referenced within it can be found in the ANSYS Forte User Guide .

Note

You can respond Yes or No to the “View chemistry set information?” prompt. A Yes re-
sponse displays the chemistry set file in a viewer.

2. Models > Transport: For this node, keep all the default settings.

3. Models > Spray Model: Since this is a direct-injection case, turn ON (check) Spray Model to display its icon
bar (action bar) in the Editor panel.

a. For the basic Spray Properties, keep Radius of Influence Model for the Droplet Collision Model and
set 0.2 cm as the Radius of Influence. The Use Vaporization Model option should be ON (checked,
its default value).

b. Create Injector: Click Spray Model in the Workflow tree. The icon bar provides two spray-injector options:

Hollow Cone or Solid Cone. For the diesel injector, click the Solid Cone  icon. In the dialog that
opens, name the Spray Model as “Injector 1”. This opens another icon bar and Editor panel for the new
solid-cone spray model. In the Editor panel, configure the model parameters for the solid-cone spray
model.

• Composition: Select Create New... in the Composition drop-down menu under Settings and click

the Pencil  icon to open the Fuel Mixture Editor. In the Fuel Mixture panel, click the Add Species
button and select nc7h16 (i.e., n-heptane) as the Species, n-Tetradecane as the Physical Properties
and 1.0 as the Mass Fraction. (Note that you must press ENTER after entering the values in the
table.)

• At the bottom of the panel, type a name such as “n-heptane”. Click Save and Close the window.

• Under the Injection Type, select Pulsed Injection and change the Parcel Specification to Number
Of Parcels and set Injected Parcel Count = 4,000.
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• Set Inflow Droplet Temperature = 368.0 K.

• Set Spray Initialization to Constant Discharge Coefficient and Angle, and Discharge Coefficient
= 0.7, and Mean Cone Angle = 15.0 degrees.

• Keep default values for Droplet Size Distribution and, under the Solid Cone Breakup Model Set-
tings, the KH Model Constants, RT Model Constants, and Use Gas-Jet Model.

• Click Apply.

c. Create a Nozzle: Click the New Nozzle  icon on the Spray icon bar and name the nozzle “Nozzle
1”. Nozzle 1 then appears in the Workflow tree, and the Editor panel and icon bar transform to allow
specification of the Nozzle geometry and orientation. In the Editor panel, set the Reference Frame
parameters to specify the nozzle location and direction. Keep the default Global Origin and use the
following settings:

• Location > Coord. System = Cylindrical, with R = 0.15 cm, θ = 22.5 degrees, and A = 19.368 cm.

• Spray Direction > Coord. System = Spherical, θ = 104.0 degrees, and ϕ = 22.5 degrees.

• Click Apply. You can see the nozzle appear at the top of the geometry. (You may wish to make the
Geometry less opaque by right-clicking the Geometry item and selecting a lower value for Opacity,
or change the color of the nozzle itself, both in the Visibility tree on the right side, to make the nozzle
easier to see in the interior.)

d. Create an Injection: In the Workflow tree, click Injector 1 again and click the New Injection  icon
on the Injector 1 icon bar and name the injection Injection 1. The new Injection item appears in the
Workflow tree, and the Editor panel and the icon bar transform to allow specification of the injection
properties. In the Editor panel, keep the Pulsed Injection Type (default), select Crank Angle as the
Timing option and then specify the Start of injection and Duration of injection as -22.5 and 7.75 de-
grees ATDC, respectively. Set the Total Injected Mass = 0.0535 g. Click Apply.

e. Injection Profile: Click the Create new... option in the profile selection menu next to Velocity Profile,
then click the pencil icon to open a new window with the Profile Editor. The new Injection Profile item
appears in the Workflow tree; also the Editor panel and the icon bar transform to the new Injection
Profile. In the Profile Editor window, make sure all the Units are set to None for both columns (the di-
mensionless data is automatically scaled within ANSYS Forte to match the mass and duration of injection)
and click the Load CSV button at the bottom of the panel (you may have to expand the panel size to
see the button). Navigate to the InjectionProfile.csv  file (see Data Provided (p. 3) ). Select Comma
as the Column delimiter and turn ON Read Column Titles and load the profile file. Alternatively, you
can type in the Injection Profile data in the table on the Editor panel or copy and paste from a spread-
sheet or 3rd-party editor. Go to Profile Name at the bottom-left of the panel and name the new profile
Injection Profile. Once the data is entered, click Save in the Profile Editor and then click Apply in the
Forte Editor panel.
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Figure 2.4:  Injection Profile Parameter Settings

4. Models > Soot Model: Turn ON the Soot Model. This creates the Settings item. In the Editor panel, accept
all the defaults.

5. Boundary Conditions: Under Boundary Conditions in the Workflow tree, specify the Boundary conditions
in the Editor panels associated with each of the four boundary conditions created by importing the mesh.
By default the Wall Model for all of the wall boundaries will be set to Law of the Wall. Leave this default
setting as well as the default check box that turns ON heat transfer to the wall.

• Boundary Conditions > Piston: Set Piston Temperature = 500.0 K. Turn ON Wall Motion with Motion
Type set to Slider Crank. The other parameters should be:

• Stroke = 15.24

• Connecting Rod Length = 30.48

• Bore = 13.97 (pre-determined by the Sector Mesh Generator)

• Accept the defaults of Piston is Offset = unchecked (OFF) and Vertices to Transform = All.

• For Reference Frame, accept the default Global Origin and Direction parameters.

• Click Apply.

• Boundary Conditions > Periodicity: Set the Sector Angle = 45 degrees, and multi-select both Periodic
A and Periodic B boundaries on which to apply this boundary condition. Click Apply.

• Boundary Conditions > Head: Set Head Temperature = 470.0 K. Click Apply.

• Boundary Conditions > Liner: Set Liner Temperature = 420.0 K. Click Apply.

6. Initial Conditions > Region 1 Initialization: Specify the parameters for the initial conditions as follows:
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• Composition: Select Constant and then Create New and click the Pencil  icon and to launch the
Composition Editor. Set these parameters: set the Composition = Mole Fraction (not the default Mass
Fraction). Then click the Add Species button and select both o2 and n2 to add. When both o2 and n2
are in the Species column in the Composition table, enter 0.126 for the o2 Fraction and 0.874 for n2.
Name this “Composition 1” in the text field at the bottom of the Gas Mixture window. Click Save and
close the Composition Editor.

• Temperature = 362.0 K

• Pressure = 2.215 bar (Note: This is not the default unit.)

• Turbulence: Select Constant, and then in the pull-down menu for the initial Turbulence parameters,
select Turbulent Kinetic Energy and Length Scale as the way in which we will specify the initial turbu-
lence. For this option we provide an explicit value for the initial turbulent kinetic energy, but use a length-
scale approximation to determine the turbulence dissipation energy. Use these values.

• Turbulent Kinetic Energy = 10,000cm2/sec2

• Turbulent Length Scale = 1.0 cm

• Velocity: Select Engine Swirl in the Velocity pull-down and then specify the swirl profile parameters:

– Initial Swirl Ratio = 0.5

– Initial Swirl Profile Factor = 3.11

– Initialize Velocity Components Normal to Piston = ON

Note

If you want to estimate the turbulent kinetic energy (TKE) as a fraction of the piston

speed, let the fraction be F and stroke is ms-1, the value you would enter then would
be

• Click Apply in the Region 1 Initialization Editor panel.

7. Simulation Controls: Under Simulation Limits, for the Simulation End Points, specify:

• Crank Angle Based

• Initial Crank Angle = -165.0

• Final Simulation Crank Angle = 125.0 degrees. (These two angles correspond to Intake Valve Open
and Exhaust Valve Closing, respectively.)

• RPM = 1,200.0

• Cycle Type is 4-Stroke.

• Click Apply.

11
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Generating the Sector Mesh



8. Simulation Controls > Time Step: For the Advanced Time Step Control Options, specify:

• Rate of Strain Factor = 1.2

• Convection Factor = 0.5

• Click Apply.

9. Simulation Controls > Chemistry Solver:

• Turn ON (check) Use Dynamic Cell Clustering and accept its defaults.

• At the bottom of the panel, set Activate Chemistry to Conditionally, specifying When Temperature
is Reached, setting Threshold Temperature = 600.0 K. Click Apply.

10. Output Controls > Spatially Resolved: For the Spatially Resolved Output Control, specify:

• Crank Angle Output Control

• Output every = 5.0 degrees.

• Also check the box next to User Defined Crank Angle Outputs and then import the UserCrankAngleOut-
puts.csv  table of data using the Profile Editor that contains crank angles going from -22 to +20, with
increment 1, units of Angle and Degree, and file named UserCrankAngleOutputs. This assures
that we get more resolved outputs around the spray, without requiring the same resolution throughout
the simulation.

• For Spatially Resolved Species, move these species to the Selection list: nc7h16, o2, n2, co2, h2o, co,
no, and no2. Click Apply.

11. Output Controls > Spatially Averaged:

• For the Spatially Averaged Output Control, select the Crank Angle option and specify Output Every
= 1.0 degree.

• For Spatially Averaged Species, select all and move all species to the Selection list. Click Apply.

12. Output Controls > Restart Data: In the Workflow tree, check the box for Restart Data and then in the Restart
panel, check the box that says, Write Restart File at Last Simulation Step. Uncheck (turn OFF) any other
boxes on the panel. Click Apply.

2.2.6.1. Run the Case Using Defaults

1. In the Workflow tree, click the Run Simulation node to open the run control interface.

2. Click the green arrow under Start to start the case running. The Status changes to “Running.”

3. To interrupt the run, click the red button under Stop. Then the Status becomes “Stopped”.

4. To start over or restart, click Start again.

5. The progress of the simulation can be monitored during a run. To monitor the averaged value of simulation

variables, click the Monitor Runs  icon on the Run Simulation icon bar.
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Figure 2.5:  Run Simulation - Icon bar.

A new window will appear, with a list of variables that can be plotted on the left panel in the window
(as described in the ANSYS Forte User Guide ). To select one or more variables to plot, check the
boxes in front of them in the Monitor Data panel.

6. When a run is finished, the Status becomes Complete in the Run panel of the man Simulate Interface
window. In the Editor Panel, use the Harvest/Visualize button to save the harvested results as a .ftres
file. Note that multiple runs can be selected for this purpose.

7. ANSYS Forte Visualizer will be loaded automatically following the “Visualize” step unless the Harvest only
option was checked. You can follow the ANSYS Forte User Guide Visualization chapter to post-process the
results.

8. You can save the project at this point using the File > Save command. Rename the project to avoid over-
writing the original .ftsim  file.

2.2.6.2. Problem Results

1. When a run is finished, the Status becomes Complete in the Run panel of the main Simulation interface
window. In the Monitor Panel, use the Harvest/Visualize button to save the harvested results as a .ftres
file. Note that multiple runs can be selected for this purpose.

2. Forte Visualizer will be loaded automatically following the “Harvest Results” step if the Launch Visualizer
after Harvest option is checked. You can follow the ANSYS Forte User Guide Visualization chapter to post-
process the results.

2.3. Reference

This case models the engine experiment from the following paper:

Singh, S., Reitz, R. D., and Musculus, M. P. B. Comparison of the characteristic time (CTC), representative
interactive flamelet (RIF), and direct integration with detailed chemistry models against optical diagnostic
data for multi-mode combustion in a heavy-duty DI diesel engine. SAE paper 2006-01-0055, 2006.
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Chapter 3: Simulating Dual Fuel Combustion

Many engine companies are now investigating the technical challenges posed by dual-fuel combustion
in engines. Dual-fuel combustion has the advantage of providing diesel-like efficiency with gasoline as
the primary fuel, providing potential increases in efficiency of 50% while reducing emissions. Typical
dual-fuel combustion designs involve the use of a small pilot injection of a liquid fuel that is relatively
easy to ignite. The pilot is injected into a lean mixture of air and a more volatile fuel that is less inclined
to autoignite, but which is port-injected to provide good mixing with the air prior to ignition. Diesel is
typically used as the pilot and it can be injected in very small amounts, sometimes referred to as micro-
pilots. Gasoline is the typical port-injected fuel for transportation applications and natural gas for power
applications. Other liquid and gaseous fuels are of interest for power applications such as landfill gas,
process gas and refinery gas. ANSYS Forte allows the use of accurate fuel models to capture fuel effects
of both the ignition and flame propagation processes in a computationally efficient manner.

ANSYS Forte uses the well established G-equation model for tracking flame propagation. In spark-ignited
engines, flame propagation is initiated by a spark event, using a kernel ignition model. For dual-fuel
cases, however, the injection and auto-ignition of the liquid pilot fuel serves to initiate the flame
propagation. In ANSYS Forte, the simulation can consider both auto-ignition and flame-propagation
modes of combustion progress simultaneously. The ANSYS Forte auto-ignition mode of initiating flame
propagation models takes advantage of a good fuel model's ability to accurately predict ignition under
auto-ignition conditions of temperature and pressure. In addition, the flame-propagation model uses
a locally calculated turbulent flame-speed that derives from fuel-specific flame-speed calculations using
detailed kinetics models. In this way, both auto-ignition and flame-propagation benefit from accurate
fuel models for low-temperature and high-temperature kinetics. The details of the autoignition-induced
flame propagation model are included in the Forte Theory Manual.

The ANSYS Forte Simulation workflow allows the use of either a body-fitted mesh or an automatically
generated mesh. In this tutorial, we will focus on the use of a mesh previously generated using the
Sector Mesh Generator.

A sector can represent the full geometry because we can take advantage of the periodicity of injector
nozzle-hole pattern and the symmetry of the cylinder. For example, a six-hole injector allows simulation
using a 60° sector (360/6). By using the symmetry of the problem in this way, the mesh created is much
smaller and the simulation therefore runs faster than it would with a complete 360° mesh.

This tutorial describes the use of 82% premixed gasoline with an 18% liquid diesel pilot for ignition.
The tutorial is based upon work previously published that also looks at 78% gasoline and 85% gasoline
cases (Puduppakkam et al. 2011, as described in Reference (p. 24)).

3.1. Data Provided

3.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select Forte tutorial files you wish to download. The files for this tutorial include:
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• itape.fmsh: This is the sector mesh file. It can only be used with body-fitted mesh calculations.

• Profile1.csv: Data describing the spray injections. These data can be entered using cut and paste or using
the Import option within the Profile Editor tool, which can be opened in the context of the spray-injection
panel on the Simulation User Interface.

• reduced-mech__RCCI-conditions_e.inp: This is the chemistry input file specifically assembled for this tutorial,
using Reaction Design’s Model Fuels Consortium II (MFC II) database to assemble a multi-component master
mechanism. This mechanism was then reduced specifically for use in the dual fuels engine case. Details of
the mechanism can be found in Puduppakkam et al. (2011). After downloading this file, it must be pre-pro-
cessed (see Pre-Processing the Chemistry Set (p. 16)).

• Dual_Fuels_82percentGasoline_BFMesh_Tutorial.ftsim: A project file of the completed tutorial, for verific-
ation or comparison of your progress in the tutorial set-up.

The sample files are provided as a download. You have the opportunity to select the location for the
files when you download and uncompress the sample files.

3.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your favorite diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.

3.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take approximately 3 hours on a

dual Intel® Xeon® processor E5-2690 at 2.90 GHz (8 total cores).

3.2. Pre-Processing the Chemistry Set

Note

All Editor panel options that are not explicitly mentioned in this tutorial should be left at
their default values. Changed values on any Editor panel do not take effect until you press
the Apply button.

The mechanism has been encrypted for use only with ANSYS Forte and ANSYS Chemkin. The encrypted
mechanism .inp file must be pre-processed.

On the Utility menu, select Pre-Processing. Choose a Working Directory and select New Chemistry
Set. Enter a Short Name for the chemistry set, such as DualFuels. For the Gas-Phase Kinetics File
entry, browse to the directory where you saved the .inp file and select reduced-mech__RCCI-condi-
tions_e.inp, and click the Open/Create button in the file browser. In the Pre-processing dialog, click
the Save As button. The .cks file with the assigned Short Name should be in the File Name entry; click

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.16

Simulating Dual Fuel Combustion



Save. In the Pre-processing dialog, click Run Pre-Processor to create the .cks file that will be imported
into ANSYS Forte. You will use this .cks file later in the tutorial. Close the confirmation dialog and the
Pre-processing window.

3.3. Importing the Mesh

You can import many different mesh and geometry file types in ANSYS Forte. In this tutorial, we will
import a sector-mesh file previously created using the Sector Mesh Generator, which is compatible with
KIVA-3V formatted files (itape file).

Select the Geometry item on the Workflow tree, then click the Import Geometry  icon and select
Body Fitted Mesh from KIVA-3V Format. In the dialog that displays, select Use the imported body-
fitted mesh directly in the simulation. Then select the downloaded itape.fmsh file described in Files
Used in This Tutorial (p. 15). ANSYS Forte will automatically create the defined surfaces in the Boundary
Conditions section of the Workflow tree based on boundary flags contained in this file. If you wish, you
can rename the geometry elements by right-clicking on an element’s name. As shown in Figure 3.1: KIVA-
3V geometry visualized in Simulate’s 3-D View after import. (p. 17), you can see the sector geometry
in the 3-D View window in the center. The geometry elements and Boundary Conditions are listed in
the Visualization tree on the right, where you can perform many operations such as turning the visibility
of the mesh ON and OFF, increasing opacity, changing color, etc., by right-clicking on the element.

Figure 3.1:  KIVA-3V geometry visualized in Simulate’s 3-D View after import.

3.3.1. Set Up the Case

Now that the mesh has been imported, you can set up the models and solver options using the guided
tasks in the Simulation Workflow tree. In many cases, default parameters are assumed and employed,
such that no input is required. The required inputs and changes to the setup panels for this case are
described here.

1. In the Workflow tree, expand Models. In the following steps you will turn ON (check-mark) some optional
models and configure parameters for each model in its Editor panel.
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2. Models > Chemistry: On the Chemistry icon bar, click the Import Chemistry  icon. This opens a file
browser where you can navigate to and select a chemistry set file. For this project, however, we use a pre-
installed chemistry set that comes with ANSYS Forte. This is a reduced mechanism specifically for these
dual-fuel conditions. To load this file, browse to the directory where you saved pre-processed .cks file and
locate the .cks file you created from the reduced-mech__RCCI-conditions_e.inp file (see Pre-Processing
the Chemistry Set (p. 16)). The chemistry file (.cks ) is a standard CHEMKIN chemistry-set file. More inform-
ation about the chemistry set and the files referenced within it can be found in the Forte User Guide .

3. Models > Transport: For this node, keep all the default settings.

4. Models > Spray Model: Since this is a direct-injection case, turn ON (check) Spray Model to display its icon
bar (action bar) in the Editor panel. In the panel, keep the defaults. Leave the Use Vaporization Model
(default) check ON.

a. Add an Injector: The icon bar provides two spray-injector options: Hollow Cone or Solid Cone. For the

diesel injector, click the Solid Cone  icon. In the dialog that opens, name the new solid-cone in-
jector as “Solid Injector”. This opens another icon bar and Editor panel for the new solid-cone injector.
In the Editor panel, configure the model parameters for the solid-cone injector.

• Composition: Select Create New... in the Composition drop-down menu under Settings and click
the pencil icon to open the Fuel Mixture Editor. In the Fuel Mixture panel, click the Add Species
button and select nc7h16 (i.e., n-heptane) as the Species, n-Tetradecane as the Physical Properties
and enter 1.0 as the Mass Fraction. At the bottom of the panel, you can keep the default name of
“Fuel Mixture 1”. Click Save and Close the window.

• Change the Parcel Specification to Number of Parcels, and the Injected Parcel Count = 3,000, its
default value.

• Set Inflow Droplet Temperature = 322.0 K.

• Set Spray Initialization to Constant Discharge Coefficient and Angle, and Discharge Coefficient
= 0.7 and Mean Cone Angle = 10.0 degrees.

• The Droplet Size Distribution is set to Uniform Size by default.

• Under the Solid Cone Breakup Model Settings, leave the KH Model Constants, and RT Model
Constants, at their default values, except for the Size constant of RT Breakup; set this value to 0.1.

• Use the Gas Jet Model, with the default parameters.

• Click Apply.

b. Create a Nozzle: While Solid Injector is selected in the Workflow tree, click the New Nozzle  icon
on the icon bar and name the nozzle Nozzle.“Nozzle” then appears in the Workflow tree, and the Editor
panel and icon bar transform to allow specification of the Nozzle geometry and orientation. Set the
parameters in the Editor panel to:

• Reference Frame: Select Global Origin from the drop-down menu. For Coord. System = Cylindrical,
with R = 0.097 cm,Θ= 30.0 degrees, and A = 18.44 cm.
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• For Spray Direction, select Spherical from the drop-down menu and then Θ = 107.5 degrees and
φ = 30.0 degrees.

• For Nozzle Size, select Area and set Nozzle Area = 0.000491 cm2.

• Click Apply. You can see the nozzle appear at the top of the geometry. (You may want to make the
Geometry non-opaque or change the color of the nozzle itself in the Visibility tree to make the nozzle
easier to see in the interior.)

Figure 3.2:  Spray cone shown after nozzle specification.

c. Add an Injection: In the Workflow tree, click Solid Injector again and click the New Injection  icon
on the Solid Injector icon bar and name the injection ”Injection 1”. The new Injection item appears
in the Workflow tree, and the Editor panel and the icon bar transform to allow specification of the in-
jection properties. In the Editor panel, select Crank Angle as the Timing option and then specify the
Start of injection and Duration of injection as -67.0 and 5.46 degrees, respectively. Set the Total In-
jected Mass = 0.015042 g.

d. Injection Profile: Click the Create new... option in the profile selection menu next to Velocity Profile,
then click the pencil icon to open the Profile Editor. The new Injection Profile item appears in the
Workflow tree, and the Editor panel and the icon bar transform to the new Injection Profile. In the Editor
panel, make sure all the Units are set to None for both columns (the dimensionless data is automatically
scaled within ANSYS Forte to match the mass and duration of injection) and click the Load CSV button
at the bottom of the panel (you may have to expand the panel size to see the button). Then navigate
to the Profile1.csv file (see Files Used in This Tutorial (p. 15)). Select Comma as the Column delimiter
and turn ON Read Column Titles and load in the profile file. Alternatively, you can type in the Injection
Profile data in the table on the Editor panel or copy and paste from a spreadsheet or 3rd-party editor.
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Once the data are entered, go to Profile Name at the bottom-left of the panel and name the new
profile “Profile1” and click Save in the Profile Editor and then click Apply in the Editor panel.

Figure 3.3:  Injection profile parameter settings

5. Add a second injection. For the second injection, the start of injection is -32.7 degrees ATDC and the
duration of injection is 2.73 CA degrees. Use the same profile as above for this injection by selecting it
from the pull-down menu next to Injection Profile. Enter the Total Injected Mass as 0.007521 g.

6. Boundary Conditions: Under Boundary Conditions in the Workflow tree, specify the Boundary conditions
in the Editor panels associated with each of the four boundary conditions created by importing the mesh.
By default the Wall Model for all of the wall boundaries will be set to Law of the Wall. Leave this default
setting as well as the default check box that turns ON heat transfer to the wall.

• Boundary Conditions > Piston: Set Piston Temperature = 500.0 K. Turn ON Wall Motion with Motion
Type set to Slider Crank. The other parameters should be:

– Stroke = 16.51

– Connecting Rod Length = 26.16

– Bore = 13.716 (this is pre-determined from the mesh)

– Accept the defaults of Piston is Offset = unchecked (OFF).

– For Reference Frame, accept the default Global Origin and Direction parameters.

– For Direction, accept the defaults of X and Y = 0.0 and Z = 1.0 for the direction of piston motion.
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– Click Apply.

• Boundary Conditions > Periodicity: Keep the default Sector Angle = 60 degrees. The periodic boundaries,
Periodic A and Periodic B, for this boundary condition are automatically selected, based on the
boundary flags contained in the imported mesh.

• Boundary Conditions > Head: Set Head Temperature = 500.0 K. Click Apply.

• Boundary Conditions > Liner: Set Liner Temperature = 430.0 K. Click Apply.

7. Initial Conditions > Region 1 Initialization (Main): Specify the parameters for the initial conditions as follows:

• In the Composition drop-down menu, select Create New... and click the pencil icon to open the Gas
Mixture Editor. In the Gas Mixture panel, change the Composition setting to Mole Fraction (not the
default Mass Fraction). Then click the Add Species button and select the species in the list indicated
in Figure 3.4: Gas Mixture Editor (p. 21). Once all the species are entered, provide the mole fraction values
as indicated in Figure 3.4: Gas Mixture Editor (p. 21). Enter a name for the Mixture if you desire or leave
the default as Mixture 1 in the bottom left text box; click Save, then Close the window.

Figure 3.4:  Gas Mixture Editor

• Temperature = 391.0 K

• Pressure = 3.34 bar (note this is not the default unit, so you need to use the pull-down next to the text
box to select the correct units option)
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• In the pull-down menu for the initial Turbulence parameters, select Turbulence Intensity and Length
Scale as the way in which we will specify the initial turbulence. For this option we leave the settings
with the default values:

• Turbulence Intensity Fraction = 0.1 (default value).

• Turbulent Length Scale = 1.0 cm (default value).

• Velocity is set to Constant.

• Select Engine Swirl in the Velocity pull-down and then specify the swirl profile parameters:

– Initial Swirl Ratio = -0.7

– Initial Swirl Profile Factor = 3.11

– Initialize Velocity Components Normal to Piston = ON (checked)

• Also keep other options at their defaults.

• Click Apply in the Region 1 Initialization Editor panel.

8. Simulation Controls: Under Simulation Limits, for the Simulation End Points, specify:

• Crank Angle Based

• Initial Crank Angle = -95.0

• RPM = 1,300.0

• Cycle Type is 4-Stroke.

• Final Simulation Crank Angle = 130.0 degrees. (These two angles correspond to Intake Valve Open
and Exhaust Valve Closing, respectively.) Click Apply.

9. Simulation Controls > Time Step:

• Maximum Time Step Option = Constant and enter the value 1.0E-5 sec. (This value is selected so the
tutorial example will run fast; the default value is 5.0E-6.)

• Leave other settings at their defaults. Click Apply.

10. Simulation Controls > Chemistry Solver:

• Accept the default state of ON (check) for Use Dynamic Cell Clustering and accept its defaults.

• Near the bottom of the panel, turn OFF (uncheck) When temperature is Reached. Set the Activate
Chemistry drop-down menu to Conditionally, specifying During Crank Angle Interval, with Starting
and Ending values of -45.0 and 40.0, respectively. Click Apply.

Note

More details about the chemistry solver options, such as Dynamic Cell Clustering and
Dynamic Adaptive Chemistry, are available in the Forte User Guide.
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11. Output Controls > Spatially Resolved: For the Spatially Resolved Output Control, specify:

• Crank Angle Output Control.

• Output every = 5.0 degrees.

• For Spatially Resolved Species, move all the fuel-related and emissions species, such as these, to the
Selection list: nc7h16, o2, co2, h2o, co, no, ic8h18, c6h12-1, c6h5ch3 and ic6h14. Click Apply.

12. Output Controls > Spatially Averaged:

• For the Spatially Averaged Output Control, select the Crank Angle option and specify Output Every
= 1.0 degree.

• For Spatially Averaged Species, select o2, co2, co, no, nc7h16, ic8h18, c6h12-1, c6h5ch3, ic6h14,
n2, h20, and move all species to the Selection list. Click Apply.

13. Output Controls > Restart Data: In the Workflow tree, check the box for Restart Data and then in the Restart
panel, check the box that says, Write Restart File at Last Simulation Step. Uncheck (turn OFF) any other
boxes on the panel. Click Apply.

3.3.1.1. Save the Project

1. In the File menu, use the Save As command to rename and save this project. The project must be saved
before running.

3.3.1.2. Run the Case Using Defaults

1. In the Workflow tree, click the Run Simulation node to open the run control interface.

2. Click the green arrow “play” button under Start/Save to start the case running. The Status changes to
“Running.”

3. To interrupt the run, click the red button under Stop. Then the Status becomes “Stopped”.

4. To start over or restart, first select the file from which you want to start, by clicking on the Browse button
in the Run row. Once an appropriate ftrst file is selected, click the green Start again.

5. The progress of the simulation can be monitored during a run. To monitor the averaged value of simulation

variables, click the Monitor Runs  icon in the Run Simulation icon bar. A new window will appear, with
a list of variables that can be plotted on the left panel in the window. To select one or more variables to
plot, check the boxes in front of them in the Monitor Data panel. These plots are shown inFigure 3.4: Gas
Mixture Editor (p. 21) to Figure 3.7: CO and UHC emissions vs. crank angle. (p. 26).

Note

To change the units of the plotted variables, go back to the Simulation Interface, Edit menu
and choose Edit Preferences. In the Preferences panel, select the units desired. The next
time the Monitor window updates the plots, it will automatically reflect these updated unit
preferences.
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3.3.1.3. Visualizing the Results

1. When a run is finished, the Status becomes Complete in the Run panel of the main Simulation interface
window. In the Monitor Panel, use the Harvest/Visualize button to save the harvested results as an .ftres
file. Note that multiple runs can be selected for this purpose.

2. ANSYS Forte Visualizer will be loaded automatically following the “Harvest Results” step if the Launch
Visualizer after Harvest option is checked. You can follow the Forte User Guide to post-process the results.

3. In the Visualizer, we are interested in creating some average line plots for Pressure, Net Heat Release Rate
(Net HRR) and emissions such as CO vs. Crank Angle. The Visualizer view when you read in the Nominal.ftres
file is shown in Figure 3.5: Simulation result in Visualizer. (p. 24). The geometry is in the 3-D Viewer window
at the center and the Visualization tree is on the right. We will use a wizard on the left to create line plots
for Pressure, Net HRR, UHC and CO. These figures are shown as Figure 3.4: Gas Mixture Editor (p. 21) and
Figure 3.7: CO and UHC emissions vs. crank angle. (p. 26).

3.4. Reference

This case models the engine experiment from the following paper:

Karthik V. Puduppakkam, Long Liang, Chitralkumar V. Naik, Ellen Meeks, Sage L. Kokjohn and Rolf D.
Reitz, “Use of Detailed Kinetics and Advanced Chemistry-Solution Techniques in CFD to Investigate Dual-
Fuel Engine Concepts”, SAE International Journal of Engines, Vol. 4, No. 1, pp. 1127-1149, 2011.

Figure 3.5:  Simulation result in Visualizer.
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Figure 3.6:  Pressure and net heat release rate vs. crank angle.
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Figure 3.7:  CO and UHC emissions vs. crank angle.
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Chapter 4: Spray Bomb Modeling

Accurately capturing fuel injection, spray breakup and spray vaporization are important aspects of engine-
design simulations for direct-injection engines. However, it is difficult to isolate the effects of spray be-
havior in a full engine simulation involving combustion, moving boundaries and complex turbulent
flow. Spray bomb experiments are an excellent method for isolating the spray behavior prior to engine
design and analysis. A spray bomb is a quiescent environment where liquid is injected without any
moving boundaries, such that the spray characteristics can be examined in detail. Any engine simulation
involving liquid injection must account for the key aspects of atomization such as liquid-jet breakup,
droplet formation, secondary breakup, droplet collisions, droplet coalescence and vaporization. This
tutorial describes how to use ANSYS Forte in spray bomb simulations that account for all of these
phenomena.

4.1. Data Provided

4.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select the Forte tutorial files you wish to download. The files for this tutorial include:

• Evaporating_Spray_Tutorial.fmsh: This is a Forte body-fitted mesh file. This file will provide the spray bomb
geometry for this Automatic Mesh Generator (AMG) tutorial.

• Evaporating_Spray_Tutorial.ftsim: A project file of the completed tutorial, for verification or comparison
of your progress in the tutorial set-up.

The tutorial sample files are provided as a download. You have the opportunity to select the location
for the files when you download and unzip or untar the sample files.

4.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your preferred diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.
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4.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take 4 hours on a cluster of 16

nodes with Intel® Xeon® processor E5-2690 at 2.90 GHz (16 cores).

4.2. Modeling Solid-Cone Spray Injection

For solid-cone spray injections, Forte utilizes the Kelvin-Helmholtz/Rayleigh-Taylor (KH-RT) spray-breakup
models that have been proven to be accurate over a wide range of direct-injection conditions. Together
with the gas-jet model, which provides accurate gas-jet entrainment calculations without requiring
mesh refinement around the spray, the ANSYS Forte spray model provides results that are insensitive
to mesh resolution or simulation time step. These spray model components are described in detail in
the Forte Theory Manual.

In many cases, the starting point for a spray injection specification is an estimate of the nozzle discharge
coefficient and spray-cone angle. Forte's nozzle-flow model can optionally provide initial conditions for
the spray model by including detailed calculation of the nozzle-flow including cavitation effects.

The droplet breakup model consists of two key models. The KH breakup model is applied within the
breakup length (see Figure 4.1: KH-RT spray model definitions. (p. 28)). The RT model is then used further
downstream with the KH model to predict secondary breakup. The unsteady gas-jet model effectively
removes mesh dependency by calculating the gas velocity in the spray region using an analytical
model.

Figure 4.1:  KH-RT spray model definitions.

Forte allows you to set several constants that control the initial breakup in the KH region and the sec-
ondary breakup in the RT region. Defaults for these constants are provided in Forte that have been

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.28

Spray Bomb Modeling



determined after extensive validation with experimental data and should be used initially. However,
there could be some cases where an adjustment in these constants would prove useful. The following
table describes the specific spray constant name, its default value, a suggested range of adjustment
and what the constant controls.

Table 4.1:  Description of default ANSYS Forte spray constants.

DescriptionAdjustment
Range

Default
Value

Constant Name

Affects radius of new
droplets formed from
initial breakup.

0.5 - 2.01.0Size Constant of KH
Breakup

Most important
constant for controlling

10 - 8040Time Constant of KH
Breakup

spray penetration
length.

Determines fraction at
which new droplets can

N/A0.03Critical Mass Fraction
for New Droplet
Generation leave their parent

parcel.

Affects the radius of
the secondary droplets

0.1 - 0.30.15Size Constant of RT
Breakup

arising from the
catastrophic breakup of
the parent droplet

Affects the
characteristic time

0.5 - 2.01.0Time Constant of RT
Breakup

required to break the
parent droplet

Affects the initial
breakup length when

1.5 - 3.01.9RT Distance Constant

the RT model is
initiated

4.2.1. Spray Bomb

4.2.1.1. Problem Description

This tutorial considers a cylindrical chamber with no moving walls and quiescent gas (see Table 4.2: Spray
bomb simulation case set-up and test conditions. (p. 30)). In this case, pure n-heptane is injected into
the chamber. This single component, fuel is injected from a single solid-cone injector, where the nozzle
hole is located on the wall and the injection is directed towards the center of the chamber. The initial
gas in the chamber is a blend of N2, CO2, and H2O, such that the mixture is non-reacting. As the intention

of this example is to represent diesel-fuel injection, we use the physical properties of n-tetradecane to
represent the fuel. This combination of chemistry model being represented by one fuel surrogate (in
this case, n-heptane) while the physical model is represented by another fuel surrogate (in this case,
n-tetradecane) is an approach often taken in simulating diesel engine combustion. In this way, the
spray-bomb simulation comparisons to experiment can be used to verify the behavior of the surrogate
model approach as it will be used in a combustion simulation. For this case, a square injection profile
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is used. Chemistry calculations are effectively stopped by setting the chemistry solver to begin at a
temperature that will not be reached during the simulation.

This tutorial shows the use of the Automatic Mesh Generator. We import a previously generated mesh
to provide the spray bomb geometry and select the option upon import to only import the geometry
surfaces for use with Automatic Mesh Generation. Mesh sizes of 1 mm, 2 mm and 3 mm are then used
to test mesh dependency. Results for penetration length of the three different mesh sizes are compared
against experimental data from SAE Technical Paper 960034 by J.D. Naber and D.L. Siebers [1 (p. 39)].

Note

All Editor panel options that are not explicitly mentioned in this tutorial should be left at
their default values. Changed values on any Editor panel do not take effect until you press
the Apply button.

Table 4.2:  Spray bomb simulation case set-up and test conditions.

Evaporating Spray CaseParameter

Disc-shaped constant-volume combustion chamber with 114.3 mm
diameter and 28.6 mm thickness

Mesh

Diesel DF2 (Experiment)Tetradecane (Surrogate)Fuel Type

436 KFuel
Temperature

1,370 barInjection
Pressure

4 msInjection
Duration

257 μmNozzle
Diameter

Pa= 40; 83; and 170 barChamber
Conditions
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Evaporating Spray CaseParameter

Ta= 1,000 K

4.2.1.2. Mesh Setup

In this tutorial, we will import an existing structured mesh with a size of 2 mm. Mesh sizes of 1 mm, 2
mm, and 3 mm will be investigated to demonstrate mesh independence of the solution. The spray
bomb geometry and test conditions are shown in Table 4.2: Spray bomb simulation case set-up and
test conditions. (p. 30).

• Import the mesh using Geometry on the Workflow tree. Click the Import Geometry  icon. In the dialog,
pull down and select Body Fitted mesh from Kiva-3Vformat, click OK and then select Only import the
geometry surfaces for use with Automatic Mesh Generation. In the dialog that opens, navigate to the
Evaporating_Spray_Tutorial.fmsh  file in the location where you saved the downloaded sample files.

• The imported file displays in the 3-D View area, but may not be ideally zoomed or centered. Click the Refit

 icon to center and resize the mesh.

• Mesh Controls: Under Mesh Controls, we need to set the Material Point to a location that will always be
“inside” the boundaries and should be located at least one unit cell length away from any boundaries. To
see the coordinate values, select Geometry > Reference Frames > Solid.1 in the left-hand Workflow tree.
The Editor panel below will show the min/max coordinates. From here we can see that the minimum and
maximum coordinate values are -5.724 and 5.714 cm for x- and y-axes, and 0 and 2.86 cm for the z-axis.
So, return to Mesh Controls > Material Point, and in the Reference Frame = Global Origin options, set x=1
cm, y=2 cm and z=1 cm, and click Apply. Once it is set, you can see the Material Point in the 3-D View
panel (as a small cube) and it can be made visible/invisible in the Visibility tree on the right, under Mesh
Controls. (You may need to adjust the opacity of the Solid.1 Geometry item in the Visibility tree.)

• In the Workflow tree, set the Global Mesh Size to 0.2 cm. This will set the default size of cells to be 2 mm
long on each side of the cell cube. Click Apply.

• Note

This is within the recommended mesh range; a coarser setting of 0.3 cm could be used
for tutorial purposes to produce a shorter runtime.

• Click the Mesh Controls node in the Workflow tree. In the icon bar, click the New Surface Refinement Depth

 icon and name the new control “surfaces”. (This indicates that along the selected surface, cells of this
smaller size will be used.) A new SurfaceDepth item appears under Mesh Controls in the Workflow tree. In
the panel that appears, select the Solid.1 surface from the Location list, set the mesh Size as Fraction of
Global Size to 1/2 with an extension of 1 layer. Click Apply.

• Click the Solution Adaptive Meshing  icon on the Mesh Controls Editor panel and name the new
control SAM-Velocity. Set the Quantity Type = Gradient of Solution Field and Solution Variables = Ve-
locityMagnitude. Bounds = Statistical and Sigma Threshold = 0.5. Set the Size as Fraction of Global
Size = 1/4. The refinement is Active = Always, and the Location option is Entire Domain. Click Apply.
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4.2.1.3. Models Setup

Chemistry: After the mesh, the models are chosen. Chemistry is set with Models > Chemistry. Click the

Import Chemistry  icon and import Diesel_1comp_35sp.cks from the installed ANSYS Forte data
directory. An option is provided to view the chemistry details such as chemistry source, pre-processing
log, gas phase input, gas phase output, thermodynamic input, transport input and transport output.
Note that in this case, the chemistry is effectively turned off, so the main reason to import the chemistry
set is to obtain the chemical species nc7h16 that will represent the fuel and n2 for the gas in the
chamber.

Transport: The default RNG k-Ε model turbulence settings are used in this tutorial. Those are specified
in the Editor panel for Models > Transport > Turbulence. The default fluid properties are also used,
which are at Models > Transport.

Spray Model: To set up the spray model, turn on (check-mark) Models > Spray Model. First, choose the
global Spray Properties, which include using the Radius of Influence model for droplet collisions with
the default Radius of Influence set to 0.2 cm. Also check Use Vaporization Model to include the effects
of vaporization, since this case is into a relatively hot gas, where vaporization will occur.

• Create Injector: Add a solid-cone spray injector through the Models > Spray Model panel, by clicking on

the Solid Cone Spray Injector  icon. Name the injector (Injector) and configure the injector and its
fuel. In the Injector Editor panel, select Create New... in the Composition drop-down menu and click the
pencil icon to open the Fuel Mixture Editor. In the Fuel Mixture panel, click the Add Species button and
select nc7h16 (i.e., n-heptane) as the Species, n-Tetradecane as the Physical Properties and 1.0 as the
Mass Fraction. (Note that you must press ENTER after entering the values in the table.) At the bottom of
the panel, type a name such as “n-heptane”. Click Save and Close the window.

• Using an Injection Type of Pulsed Injection, change the Parcel Specification to Number of Parcels, then
set Injected Parcel Count = 5,000.

• Set Inflow Droplet Temperature = 436.0 K.

• Set Spray Initialization to Constant Discharge Coefficient and Angle, and Discharge Coefficient = 0.78,
and Mean Cone Angle = 19.04 degrees.

• Keep default values for Droplet Size Distribution and, under the Solid Cone Breakup Model Settings, for
the KH Model Constants, RT Model Constants, and Use Gas-Jet Model. Click Apply.

Next we will add the nozzle and specify the injection parameters under this new injector (see
Table 4.4: Nozzle settings. (p. 33) and Table 4.5: Injection settings. (p. 33)).

Table 4.3:  Injector Settings

SettingParameter

5,000Injected Spray Parcels

436.0 KInflow Droplet Temperature

Constant Discharge Coefficient
and Angle

Spray Initialization

0.78Discharge Coefficient

19.04Mean Cone Angle
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• Create a Nozzle: Click the New Nozzle  icon on the Injector icon bar and name the nozzle “Nozzle”.
The Nozzle item then appears in the Workflow tree, and the Editor panel and icon bar transform to allow
specification of the Nozzle geometry and orientation. Set the parameters in the Editor panel to use the
Reference Frame parameters to specify the nozzle location and direction. Keep the Global Origin and use
the following settings:

Table 4.4:  Nozzle settings.

SettingParameter

Location

CylindricalCoordinate System

5.7 cmR

180.0 degrees•

1.43 cmA

Spray Direction

SphericalCoord. System

90.0 degreesθ

0.0 degrees•

Nozzle Size

257 micronsNozzle Diameter

• If you cannot see the nozzle in the 3-D View, you may need to adjust the opacity or color choice of the nozzle
or the boundary conditions that may be blocking your view of it. Select the desired item in the Visualization
tree (on the right side) and right-click to turn ON/OFF visualization, change opacity levels, or change the
color assigned to that item.

• Create an Injection: In the Workflow tree, click Injector again and click the New Injection  icon on the
Injector icon bar and name the injection Injection. The new Injection item appears in the Workflow tree,
and the Editor panel and the icon bar transform to allow specification of the injection properties. In the
Editor panel, use the following settings:

Table 4.5:  Injection settings.

SettingParameter

TimeTiming

0.0 secStart

0.004 secDuration

Square ProfileVelocity Profile

0.058 gTotal Injected Mass

The resulting injection profile can be viewed by clicking on the pencil icon next to the Velocity Profile
entry box. In this window, you can also import a new velocity profile for the injection from a .csv file
or make edits directly in the table (see Figure 4.2: View injection profile. (p. 34)).

33
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Modeling Solid-Cone Spray Injection



Figure 4.2: View injection profile.

4.2.1.3.1. Boundary Conditions

Create a new boundary by right-clicking on the Boundary Conditions Workflow tree, and Add a Wall.
Now, under the Boundary Conditions Workflow tree node, a new entry called Wall will be found. Under
Location for the Wall boundary condition, select Solid.1. The only boundary condition that must be
specified for the wall and liner is temperature. For both Boundary Condition > Head and Liner, select
the No Slip model for handling the boundary layer near the wall and set the Temperature = Constant
and Temperature = 451 K. Keep Heat Transfer checked (ON).

4.2.1.3.2. Initial Conditions

Initial conditions will be set only for the Default Initialization region. Specify the parameters for the
initial conditions as follows:

• Composition: Use the Composition Editor to set these parameters: In the Gas Mixture Editor, keep the
Composition = Mass Fraction. Then click the Add Species button and select h2o, co2 and n2 to add. When
these 3 species are in the Species column in the Composition table, enter 0.9033 for the n2 Fraction,
0.0611 for co2 and 1.0 for h2o. Name this Composition 1 in the text field at the bottom of the Gas Mixture
window. Click Save and close that window.

• Temperature = 1,000.0 K.

• Pressure = 83.04 atm.

• In the pull-down menu for the Turbulence parameters, select Turbulence Intensity and Length Scale as
the way in which we will specify the initial turbulence. For this option we provide an explicit value for the
initial turbulence intensity, but use a length-scale approximation to determine the turbulence dissipation
energy. Use these values:

– Turbulence Intensity Fraction = 0.0.
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– Turbulent Length Scale = 1.0 cm.

• Select Velocity Components in the Velocity pull-down and then specify the velocity components, using
the default Reference Frame with Global Origin and Cartesian coordinates set at 0.0, 0.0, 0.0.

• Click Apply in this panel.

4.2.1.3.3. Parameter Study on Pressure

To create a parameter study on pressure, click the Parameter Study  icon next to the Pressure setting
(at 83.04 atm). In the resulting dialog, change the specification to From End Points, set these values:
First run value (A) 40.0, Last run value (B) 170.0, Number of runs (n) 2. Click OK.

Close or minimize the Parameter Studies window. Note that the Pressure label in the Editor panel is
now blue to indicate that it is associated with a parameter study.

Figure 4.3:  Spray - Parameter study on pressure.

When this simulation runs, a run will occur at each of these pressure settings. See Results (p. 37) to see
how the results vary with the changes in pressure.

4.2.1.3.4. Simulation Controls

Simulation controls allow you to define the simulation limits, time step, chemistry solver and transport
terms.

Simulation Limits: Select the Simulation Controls node and then use Simulation Limits to select a
Time-based simulation with a Max. Simulation Time of 0.004 sec.

Time Step: Use Simulation Controls > Time Step to set the Initial Simulation Time Step to 5.0E-7 sec
and use a Constant Max. Time Step Option of 5.0E-6 sec. Advanced Time Step Control Options can
be left at the default settings.

4.2.1.3.5. Chemistry Solver

Use Simulation Controls > Chemistry Solver so Activate Chemistry is Always Off (at the bottom of the
panel) to prevent the chemistry from being solved in this non-reacting case.

4.2.1.3.6. Transport Terms

The transport tolerances and maximum number of iterations are left at their default values.
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4.2.1.4. Output Controls

Output controls determine what data are stored for viewing during the simulation and for creating
plots, graphs and animations in the ANSYS Forte Visualizer.

Spatially Resolved: Set the Temporal Output Control reporting every 0.004 sec. To create the Spatially
Resolved Species list, be sure to move nc7h16 to the Selection list. Also move n2, co2, and h2o. Under
Restart, clear (uncheck) the option Write Restart File at Last Simulation Step. Click Apply.

Spatially Averaged: Set the Temporal Output Control reporting every 4.0E-5 sec. To create the
Spatially Averaged Species list, be sure to move nc7h16 to the Selection list. Also move co2, o2, and
n2. Click Apply.

4.2.1.5. Save Project

Save your project with the Save command in the File menu, but choose a new name for the project
to avoid overwriting the original .ftsim file. The saving step includes validation of the project.

4.2.1.6. Run Settings

The settings here depend on the system and environment for your simulations. The default for the Run
Settings panel is to have nothing selected.

Run Options: Under Job Script Options, change Default Run Type to Parallel and change the default
MPI Arguments to 8. (If you do not have MPI installed and configured, keep the default of a serial run.)

4.2.1.7. Run Simulation

All that is needed to be done now is to select Run Simulation and click on Start once ANSYS Forte has
given you the green light and reports that it is ready for the simulation. You can monitor the results
by clicking on the Monitor icon. In the Monitor window that opens, you can select which result you
want to monitor for the spray such as Mass Injected and Penetration Length.

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.36

Spray Bomb Modeling



Figure 4.4:  Monitor ANSYS Forte run

4.2.1.8. Results

This spray bomb case was run with three mesh sizes (1 mm, 2 mm and 3 mm) and then compared
against experimental data from Naber and Siebers 1 (p. 39). The experimental data provided consisted
of penetration depth for the test spray. The experimental data show a penetration depth of 22.6 mm
as is shown in Figure 4.5: Mesh sensitivity on spray penetration depth (p. 38). The simulation results
show good agreement with the spray penetration depth as is also seen in Figure 4.5: Mesh sensitivity
on spray penetration depth (p. 38). It is important to note that ANSYS Forte defines the spray penetration
depth that captures 95% of the liquid. These results also show that the spray is relatively insensitive to
the mesh for the three mesh sizes considered. The 1 mm and 2 mm results lie on top of each other.
The diversion of the results for 3 mm, suggest that size is a little too large to resolve the fluid mechanics
overall and so for these types of cases we would recommend the 2 mm resolution. However, even the
coarse mesh results are not far from the resolved-mesh solution, which is an important feature of the
ANSYS Forte simulations. Another interesting feature is to look at the how the droplet mass and vapor
mass evolve during the simulation time. These results are shown in Figure 4.6: Mesh sensitivity on droplet
mass and vapor mass (p. 38), where the mesh is also shown to be insensitive to the mesh size, even
with the coarsest mesh. Visualization of the spray results are shown in Figure 4.7: Spray bomb penetration
for 2 mm mesh. (p. 39) at time = 0.0015 sec.

The results of the automated parameter study on ambient pressure in the spray bomb are shown as
Figure 4.8: Results of automated parameter study on ambient pressure in the spray bomb. (p. 39). The
spray penetration is decreased as the ambient pressure increases due to the increased chamber gas
density and drag.
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Figure 4.5:  Mesh sensitivity on spray penetration depth

Figure 4.6:  Mesh sensitivity on droplet mass and vapor mass
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Figure 4.7:  Spray bomb penetration for 2 mm mesh.

Figure 4.8:  Results of automated parameter study on ambient pressure in the spray bomb.

4.3. Reference

This tutorial is based on the work in this published paper:

1. Naber, J. D. and Siebers, D. L.,“Effects of Gas Density and Vaporization on Penetration and Dispersion of
Diesel Sprays”, SAE Technical Paper 9p60034, 1996.
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Chapter 5: Port-Injected Spark Ignition Engine

This tutorial describes how to use ANSYS Forte CFD to simulate combustion in a port-injected spark
ignition internal combustion engine with moving valves. Engine geometry is imported and ANSYS
Forte's automatic mesh generation is used to create the computational mesh on-the-fly during the
simulation.

5.1. Data Provided

5.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select the Forte tutorials desired for download. The files for this tutorial include:

• SIEngine_Sample.stl: This is the geometry file.

• ExhaustLift.csv  and IntakeLift.csv: Two files of data describing the intake and exhaust valve lifts. Profiles
such as these can be imported (from .csv files) or manually entered in the Profile Editor.

• Spatial_Output_CAs.csv: Specifies when spatially resolved data such as velocity, temperature, species
concentrations, etc., will be output.

• SIEngine_PortInjected_AMG_Tutorial.ftsim: A project file of the completed tutorial, for verification or
comparison of your progress in the tutorial set-up.

The sample files are provided as a download. You have the opportunity to select the location for the
files when you download and uncompress the sample files.

5.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your favorite diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.

5.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take approximately 20.2 hours on

a cluster with 16 nodes with dual Intel® Xeon® processor E5-2690 at 2.90 GHz (8 total cores).
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5.2. Port-Injected Spark Ignition Engine

5.2.1. Problem Description

The port-fuel injection is approximated by a premixed, pre-vaporized blend of fuel and air in the intake
port. There are two exhaust and intake valves and the simulation domain includes the intake and exhaust
manifolds (Figure 5.1: Port-injected engine geometry with valves and ports defined (p. 43) ). In other
words, the initialization of the gas composition is used to specify the fuel-air mixture in the intake-port
region and perfect mixing within the port is assumed. The case is reacting flow, with a single component,
59-species single-component fuel that is appropriate for engine simulations that are not concerned
with knock. See the ANSYS Forte User Guide for details of the chemistry.

5.2.1.1. Import the Geometry

Note

All Editor panel options that are not explicitly mentioned in this tutorial should be left at
their default values. Changed values on any Editor panel do not take effect until you press
the Apply button. Always press the Apply button after modifying a value, before moving
to a new panel or the Workflow tree.

In this tutorial, we will import an existing geometry into ANSYS Forte and set up the automatic mesh
generation using a global mesh size and adapting the mesh near the valves. To import the geometry,
go to the Workflow tree and click Geometry. This opens the Geometry icon bar. Click the Import Geo-

metry  icon. In the resulting dialog, pull down and select Surfaces from STL file. In the dialog that
opens with STL file import options, accept the defaults.

The mesh will be automatically generated during the simulations. When the file browser launches,
navigate to the folder Tutorial_SIENGINE_PFI_Automesh then select SIEngine_sample.stl. Note that
once you have imported the geometry, there are a number of actions that you can perform on the
items in the Geometry node, such as scale, rename, transform, invert normals, or delete geometry ele-
ments.

The Geometry imports in an opaque mode and possibly preset zoom level. It is often helpful to Re-

fit the view or use the mouse wheel to re-zoom. To change opacity, right-click the Geometry node
in the right-side Visibility tree and select Medium for the Opacity level of all geometry elements, as
shown in Figure 5.1: Port-injected engine geometry with valves and ports defined (p. 43).
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Figure 5.1:  Port-injected engine geometry with valves and ports defined

5.2.1.2. Subvolume Creation

Subvolumes are useful to refine regions of interest, such as the chamber. The subvolume can then be
used in the mesh controls to control the size of the mesh in the selected subvolume. On the Workflow
tree, use Geometry > Sub-Volume to create a subvolume named Sub-Volume-Cylinder. Select the fol-
lowing surfaces to define the subvolume: Head, Liner, and Piston. For the Material point, accept the
default Reference Frame using the Global Origin. Set the Location using Cartesian Coord. System
to X = 0, Y = 0 and Z = 1.0 cm. Click Apply.

5.2.1.3. Automatic Mesh Generation Setup

The Material Point is the point in the domain that tells ANSYS Forte where the mesh will be generated
and should be located at least one unit cell length away from any boundaries. This point must be inside
of the domain throughout the entire simulation. Typically it is located near the head so it is still inside
the domain at TDC.

• Mesh Controls > Material Point: Accept the default Reference Frame using the Global Origin. Set the Loc-
ation using Cartesian Coord. System to X = 0, Y = 0 and Z = 1.0 cm. Apply.

• From the Workflow tree, use Mesh Controls > Global Mesh Size to set the global Mesh Size to 0.2 cm.

Note

This is the recommended mesh size; a coarser setting of 0.3 cm could be used for tutorial
purposes to produce a shorter runtime.

• Set the Small Feature Deactivation Factor to 0.5.

Next, you will refine the mesh around key geometric features such as valves and the piston, walls, and
open boundaries (“continuative outflows”). The following steps show how the mesh is refined for key
geometric features. From the Mesh Controls node, you can add Point, Surface, Line, or Feature Re-
finements, or Small Feature Avoidance Controls. We recommend the following general practices for
setting mesh refinement in a full-cycle 4-stroke engine simulation that includes ports and valves:

1. Refinement at Wall Boundaries. Use ½ the global mesh size where the mesh intersects with the wall
boundaries. An extended layer of refinement is added by default to ensure that the refinement includes a
full layer when the Cartesian mesh intersects curved or slanted boundaries.
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• Surface Refinement: Click the Mesh Controls node in the Workflow tree. In the icon bar, click the New

Surface Refinement Depth icon and name the new control AllWalls. (This indicates that along the
selected surfaces, cells of this smaller size and greater refinement will be used.) A new AllWalls item ap-
pears under Mesh Controls in the Workflow tree. In the panel that appears, select all of the items in the
Location list, except be sure to exclude the Pressure_In and Pressure_Out open-boundary surfaces (we
will set up refinement along these surfaces separately). Be sure the list’s scroll bar is showing to ensure
all the list items are displayed. Accept the default mesh Size as Fraction of Global Size as ½. Set the
Number of Cell Layers to Extend Refinement from Surface to 1. Keep the default of Active to Always
in the pull-down list below the refinement-layer entry. Click Apply. An initial refinement is applied over
all wall boundaries with a ½ Size Fraction of Global Size.

2. Refinement at Open Boundaries (Continuative Outflows). Again, we will use ½ the global mesh size at
continuative outflows, but use 2 extended layers of refinement, to make sure the continuative outflows
have smooth refinement where the inlet intersects walls.

• In the Mesh Controls icon bar, click the New Surface Refinement Depth  icon and name the new
control OpenBoundaries. In the panel that appears, select all of the open-boundary surfaces (the
Pressure_In and Pressure_Out boundary surfaces) from the Location list. Accept the default mesh Size
as Fraction of Global Size as 1/2. Set the Number of Cell Layers to Extend Refinement from Surface
to 2. Click Apply. An initial refinement control is applied over all wall boundaries with a ½ Size Fraction
of Global Size.

3. Refinement Around the Valve Stems. Here we want to make sure we have smaller cells in the regions
around the valve stems, where velocities will be greatest during intake and exhaust portions of the cycle.

• Click the New Surface Refinement Depth  icon (on the Mesh Controls icon bar) and name the new
item ValveStems. Select IntakeValve1_Stem, IntakeValve2_Stem, and ExhaustValve1_Stem, and
ExhasutValve2_Ste in the Location list. Set the Size as Fraction of Global Size to 1/2 and set the
Number of Cell Layers to Extend Refinement from Surface to 10. Make this Active = Always.

4. Refinement Around the Valve Ends that Seat to the Port. As above, we want to assure sufficient refine-
ment where velocities will be greatest during valve opening and closing.

• Click the New Surface Refinement Depth  icon and name the new item ValveSeats. Select Exhaust-
Valve1_Seat, ExhaustValve2_Seat, IntakeValve1_Seat and IntakeValve2_Seat in the Location list.
Set Size as Fraction of Global Size to 1/4 and set the Number of Cell Layers to Extend Refinement
from Surface to 1. Make this Active = Always.

5. Refinement Near Piston and Head at TDC positions (Squish regions): The squish regions require refine-
ment near TDC at the end of compression strokes to make sure that there are at least a couple of cells
separating the head and piston surfaces in all locations. These controls are dynamic controls, since they
are only necessary near the TDC position of the crank.

• Click the New Surface Refinement Depth  icon and name the new item Squish1. Select Head, Ex-
haustValve1_Seat, ExhaustValve2_Seat, IntakeValve1_Seat, IntakeValve2_Seat, Linerand Piston
from the Location list. Change Size as Fraction of Global Size to 1/4. Set Number of Cell Layers to
Extend Refinement from Surface to 1. Make this Active = During Crank Angle Interval and Start
angle = 340.0 degrees and End angle = 380.0 degrees. Click Apply.

• Use the Copy and Paste icons in the icon bar of the Squish1 panel and name the new item Squish2.
Make this Active = During Crank Angle Interval and set Start angle = 690.0 degrees and End angle
= 790.0 degrees. Click Apply.
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6. Add a Point Refinement Depth for the region of the spark: : Capture the chemistry around the spark.

• Click the Point Refinement Depth  icon and name it SparkRegion. Set the Location as: X = -0.36
cm, Y = 0 cm, Z = 0.33 cm, with the Radius of Application = 0.5 cm and the Refinement level = 1/4.
The refinement is Active between Crank Angle 680 and 720 degrees. Click Apply.

7. Adaptive Refinements: Adaptively refine based on the solution variables temperature and velocity.

• Click the Solution Adaptive Meshing  icon and name the new control SAM-Temperature. Set the
Quantity Type = Gradient of Solution Field and Solution Variables = Temperature. Bounds Option
= Statistical and Sigma Threshold = 0.5. Set the Size as fraction of Global Size = 1/4. The refinement
is Active between Crank Angle 680 and 800 degrees, and the Location option is Sub-Volumes = Sub-
volume-Cylinder. Click Apply.

• Click the Solution Adaptive Meshing  icon and name the new control SAM-Velocity. Set the
Quantity Type = Gradient of solution field and solution variable = VelocityMagnitude. Bounds
Option = Statistical and Sigma Threshold = 0.5. Set the Refinement level = 1/2. The refinement is
Active = Always, and the Location option is Entire Domain. Click Apply.

5.2.1.4. Models Setup

Chemistry: Now that the mesh has been set up, assigning models is next. Assign the chemistry with

Models > Chemistry and use the Import Chemistry icon and select the file Gasol-
ine_1comp_59sp.cks from the ANSYS Forte data directory. If you are curious, you can view the chemistry
details, such as chemistry source, pre-processing log, gas phase input, gas phase output, thermodynamic
input, transport input and transport output.

• Flame Speed Model: Use Models > Chemistry > Flame Speed Model to access the settings for the Flame
Speed model. Keep all the defaults, except under Turbulent Flame Speed (at the bottom of the Editor
panel), set Turbulent Flame Speed Ratio (b1) to 2.0. Click Apply.

Transport: The default RNG k-ε model turbulence settings are used in this tutorial. Those are specified
in the Editor panel for Models > Transport > Turbulence. The default fluid properties are also used,
which are at Models > Transport.

Spark Ignition: Turn on the spark ignition model by checking the box at Models > Spark Ignition.

The spark ignition model defaults include a Kernel Flame to G-Equation Switch Constant of 2.0 and the
Flame Development Coefficient of 0.5.

Use the New Spark icon to create a new spark event and name it Spark.

Use Models > Spark Ignition > Spark to set up the details of the spark event. In the Reference Frame,
use Global Origin and Cartesian coordinates for the Location, and set X= -0.36 cm, Y=1.0E-6 cm,
and Z=0.33 cm. Select Crank Angle for Timing and Starting Angle = 688.0 degrees, Duration = 10.0
degrees. Under Spark Energy, set Energy Release Rate = 20.0 J/sec. Accept the default 0.5 for Energy
Transfer Efficiency and 0.5 mm for Initial Kernel Radius. Click Apply.
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5.2.1.5. Boundary Conditions:

Boundary conditions are specified for each of the geometry elements in Boundary Conditions > geometry-
element-name, where geometry-element-name is each of the items under Geometry in the Workflow
tree.

Inlet: From the Boundary Conditions node, click the New Inlet icon and create Inlet. Select Pressure_In
from the Location list. Select Pressure Inlet as the Inlet Option with a constant pressure of 0.8 bar.
You will set the inlet composition to the correct Mass Fraction values corresponding to the premixed
fuel and air:

• o2=0.1967

• h2o=0.0089

• co2=0.0192

• ic8h18=0.0562

• n2=0.7190

To do this, select Create New in the Composition dropdown list above the Location list and click the

Pencil icon. This opens the Gas Mixture panel, where you select Add Species and then choose the
species you want from the mechanism (see Figure 5.2: Gas Mixture Editor: Defining Inlet gas composi-
tion (p. 46)). You can find a species more quickly by typing (the beginning of ) the species name to filter
the list. Save the inlet gas mixture as StoichWith10PercEGR. You will then see a list to define turbulence

using Turbulent Kinetic Energy and Length Scale of 7,900 cm2 /sec2and 0.5 cm, respectively.

Figure 5.2:  Gas Mixture Editor: Defining Inlet gas composition

Outlet: From the Boundary Conditions node, click the New Outlet icon and create Outlet. Select the
Pressure_Out geometry item and select the Total Pressure as the Outlet Option. Give the outlet a
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Pressure of 0.9 bar, which arises from the back-pressure of the exhaust system with an Offset Distance
to Apply Pressure of 0.1 cm. Set the Turbulence Boundary Conditions to Turbulent Kinetic Energy

and Length Scale of 7,900 cm2/sec2and 0.5 cm,respectively.

Piston: From the Boundary Conditions node, click the New Wall icon and name it Piston. Select the
Piston item in the Location list. Set the Temperature Option to Constant and 420 K. Turn ON the
Wall Motion option and set the piston Motion Type to use a Slider-Crank Model with a Stroke of
7.95 cm and a Connecting Rod Length of 13.81 cm with 0.0 Piston Offset. Change the Movement
Type to Moving Surface and accept the default Global Origin Reference Frame.

Intake: Click the New Wall  icon and name it Intake. Select the IntakeManifold item in the Location
list and set the Temperature to 300 K.

Exhaust: Click the New Wall  icon and name it Exhaust. Select the ExhaustManifold item in the
Location list and set the Temperature to 650 K.

Liner: Click the New Wall  icon and name it Liner. Select the Liner item in the Location list and set
the Temperature to 385 K.

Head: Click the New Wall  icon and name it Head. Select the Head item in the Location list and set
the Temperature to 385 K.

Intake Valves: Click the New Wall icon and name it IntakeValve 1. The valve specification is a little
more complicated than the stationary walls, such that several steps are required within the wall panel.
These steps specify the wall motion and the way we want the mesh to adapt to the gap opening near
the valve seat when the valve opens or closes.

• Multiselect both the IntakeValve1_Seat and IntakeValve1_Stem items in the Location list.

• Check the Heat Transfer option and set the Temperature to the constant value of 385 K.

• Turn ON (check) the Wall Motion and set the Motion Type to Offset Table.

• Accept the default Global Origin for the Reference Frame. Select Spherical for the Coord. System under
Direction for the valve motion and set Q=199 degrees and f =0.0 degrees.

• To import the lift profile (named IntakeLift.csv in the same location as the .stl file you started this tutorial

with), select Create New from the Lift Profile drop- down list and click the Pencil icon. In the Profile
Editor, click the Load CSV button and navigate to the IntakeLift.csvfile. Accept the defaults in the import
dialog and click OK. At the bottom of the Profile Editor window, name this IntakeValves. Ensure that the
units in the first column are set to Angle and the second column is set to cm. Save the Profile.

• For Movement Type, change the pull-down menu to Valve. Then select just the surface boundary portion
of the valve that comes into contact with the valve seat on the port, as well as the surface boundary that
contains the seat region. In this case, select both the IntakeManifold and the IntakeValve1_Seat.

• Finally, set the Valve Motion Activation Threshold to 0.15 cm. This indicates that the valve will not open
until the lift value specified in the valve-lift profile exceeds this threshold. A smaller value will cause the
valves to open sooner, but the mesh refinement required to resolve the gap will be higher. This is a trade-
off that will need to be determined based on the goals and outcomes desired from the simulation. In addition
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to the activation threshold, you may also change the minimum number of cells desired at the smallest gap
opening. In this case, accept the default value for Approx. Cells in Gap at Min. Lift of 3.0.

Follow the same procedure to set the boundary conditions for IntakeValve 2. This time you can select
the existing IntakeValves profile instead of creating a new one. And for IntakeValve 2, the Location
selected should be IntakeValve2_Seat and IntakeValve2_Stem, while the surfaces selected under
Multiselect the Valve Seat and Surface it Contacts should be the IntakeManifold and IntakeValve2_Seat.

Exhaust Valves: Click the New Wall icon and name it ExhaustValve1. Follow a similar procedure as
for the Intake Valves. This time, select the ExhaustValve1_Seat and ExhaustValve1_Stem items in the
Location list and set the Temperature to 497 K. Turn ON the Wall Motionand set the Motion Type
to Offset Table and the Vertices to Transform to Interior. Select Global Origin for the Reference
Frame. Select Spherical for the Coord. System under Direction and set Q = -199 degrees and f =0.0
degrees (note that this is the opposite direction from the intake valves, relative to the z-axis). Similarly
to the intake valves, first import the .csv(named ExhaustLift.csv) file, accept the defaults, and name it
ExhaustValves. Then follow the same procedures for specifying the Movement Type to Valve, selecting
the Valve Seat and Surface it Contacts(ExhaustManifold and ExhaustValve1_Seat), and setting the
Valve Motion Activation Threshold to 0.15 cm.

Follow the same procedure to set the boundary conditions for ExhaustValve2. Use the ExhaustValves
profile again for ExhaustValve2, but select the appropriate surfaces for the ExhaustValve2 in the Location
list and in the Multiselect the Valve Seat and the Surface it Contacts list.

5.2.1.6. Initialization

The domain is initialized with the operating conditions, species concentrations and temperatures. The
Default Initialization species composition is at the expected exhaust composition, assuming complete
combustion. The intake and exhaust must also be initialized to the boundary condition values. Set the
following initialization parameters:

Default Initialization:

• Select Default Initialization in the Workflow tree. Set the Initialization Order  to 2. Since flow goes generally
from the intake to the cylinder and then to the exhaust, this indicates that this default (cylinder) region will
be the second in the initialization order precedence list.

• Select Create New in the Composition drop-down list and click the Pencil icon. This opens the Gas Mixture
panel, where you select Add Species, set to a Mass Fraction of n2=0.7192, co2=0.1923 and h2o=0.0885
and Save this composition as ExhaustEst_w10percEGR.

• Set a Temperature of 1,000 K and the Pressure to 1.0 bar.

• The Turbulence initialization uses the Turbulent Kinetic Energy and Length Scale option with values

7,900 cm2/sec2 and 0.4 cm, respectively.

• The Velocity is initialized using Engine Swirl, with an Initial Swirl Ratio of -0.0739, an Initial Swirl Profile
Factor of 3.11, and checking (ON) Initialize Velocity Components Normal to Piston.

• Click Apply.

Intake Initialization: The intake manifold Initial Condition is set to match the Boundary Condition at
the Inlet. Since this is a separate port that can be closed off from the main cylinder region, we also
need to set the equivalent of a material point to identify the region, as well as an initialization order
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that helps determine what region takes precedence in initializing new cells that appear when gaps are
opened.

• From the Initial Conditions Workflow tree item, select the New Port Initialization icon and name it Intake.

• To identify the region, select a point for the Location under the Reference Frame selection, which is a point
that will always be within the Intake port. Set the coordinates for this case to X=6.0, Y=2.0, Z=5.0 cm,
which is a point just inside the inlet.

• Set the Initialization Order to 1. Flow is expected to go from the intake to the main region; for this reason,
we give it the first order in initialization precedence.

• Set the Composition by selecting in the previously saved profile, StoichWith10PercEGR. Set the Temper-
ature to 300 K and Pressure to 0.8 bar.

• The Turbulence initialization uses Turbulent Kinetic Energy and Length Scale option set to 7,900

cm2/sec2and 0.5 cm, respectively. ClickApply.

Exhaust Initialization: The Initial Conditions of the Exhaust is set to match the Boundary Condition of
the Outlet.

• From the Initial Conditions Workflow tree item, select the New Port Initialization icon and name it Exhaust.

• To identify the region, select a point for the Location under the Reference Frame selection, which is a point
that will always be within the ExhaustPort region. Set the coordinates for this case to X= -4.0,Y=2.0, Z=2.0
cm, which is a point just inside the outlet.

• Set the Initialization Order to 3. Flow is expected to go from the cylinder to the exhaust port; for this reason,
we give it the last order in initialization precedence for the 3 regions defined.

• Set the Composition to the existing profile, ExhaustEst_w10percEGR. Set the Temperature to 650K and
Pressure to 0.9 bar.

• The Turbulence initialization uses the Turbulent Kinetic Energy and Length Scale option; these are set

to 7,900 cm2/sec2and 0.5cm, respectively. Click Apply.

5.2.1.7. Simulation Controls

Simulation controls allow you to define the simulation limits, time step, chemistry solver and transport
terms.

Simulation Limits: Use the Simulation Controls panel to select a Crank Angle-based simulation from
a CA of 340 to 900 degrees. Set RPM = 1,500 rpm. The engine Cycle Type is 4-Stroke.

Time Step: Use Simulation Controls > Time Step and set the following parameters:

• Initial Simulation Time Step to 5.0E-7 seconds

• Select Restrict Time Step by Crank Angle

• Max. Crank Angle Delta Per Time Step of 1.1 degrees

• Set the Max. Time Step Option to Constant and set the value of Max. Simulation Time Step to 3.E-5 sec.
The time step will be adaptively determined throughout the simulation, based on local solution gradients,
so this just sets the maximum value allowed.
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TheAdvanced Time Step Control Options settings are kept at the defaults:

• Time Step Growth Factor = 1.3

• Fluid Acceleration Factor = 0.5

• Rate of Strain Factor = 0.6

• Convection factor = 0.2

• Internal Energy Factor = 1.0

• Max. Convection Subcycles = 8

Chemistry Solver: Simulation Controls > Chemistry Solver is also kept at the defaults, with the following
parameters:

• Absolute Tolerance = 1.0E-12

• Relative Tolerance = 1.0E-5

• Use Dynamic Cell Clustering to take advantage of groups of cells with similar conditions. Select 2 features
to introduce Dynamic Cell Clustering: 1) Max. Temperature Dispersion of 10 K and 2) a Max. Equilibrium
Ratio Dispersion of 0.05.

• To increase the time-to-solution speed, you have the ability to choose when chemistry is activated. In this
tutorial, select Activate Chemistry Conditionally, and select When Temperature is Reached with Threshold
Temperature 600 K and also select During Crank Angle Interval between 650 and 850 crank angle. This
ensures that chemistry is active during the time that combustion is expected even if temperature does not
rise above 600 K. Click Apply.

Transport Terms:Use the default transport tolerances and maximum number of iterations.

5.2.1.8. Output Controls

Output controls determine what data are stored for viewing during the simulation and for creating
plots, graphs and animations in ANSYS Forte Visualize.

Spatially Resolved: Allows you to control when spatially resolved data such as velocity, temperature,
species concentrations, etc., will be output. In the Spatially Resolved panel, set theCrank Angle Output
Control to report every 10 degrees (to manage the size of the output file). You can optionally increase
the frequency of output during the cycle by selecting User Defined Output Control and importing
the Spatial_Output_CAs.csv file, which has a list of specific crank angles where spatially resolved output
will occur (illustrated in Figure 5.3: Output control panel - Spatially Resolved. (p. 51)). Alternatively, you
could select User Defined Output Control, and use the Profile Editor to create some other file specifying
an output crank-angle profile (the provided profile is illustrated in Figure 5.4: User-defined spatially re-
solved output controls. (p. 51)). Select the following species for Spatially Resolved Output: h2o, no,
no2, co, co2, o2, ic8h18 and n2.
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Figure 5.3:  Output control panel - Spatially Resolved.

Figure 5.4:  User-defined spatially resolved output controls.

Spatially Averaged:Allows you to control the output of values that are averaged across the domain.
Spatially Averaged panels, set the Crank Angle Output Control to reporting every 1 degree. Select
the following species for Spatially Averaged Output: h2o, no, no2, co, co2, o2, ic8h18 and n2.

Restart Data: If you anticipate that the case will be stopped and you want the ability to restart it from
the last time step solved, select Output Controls > Restart Data. You can specify certain Restart Points
using a separate file. Turn on (check) User Defined Restart Points and use the Profile Editor to create
a Restart profile. You can view, edit or import new Restart Points in this 1-D Profile Editor. Sometimes
it is helpful in spark ignition cases to save a restart file after IVC but before the spark occurs (CA=687
in this case) so you can use the compression portion of the cycle as a start point in additional runs.
Create a new profile for this purpose called RestartOutput and add one line with CA value set to 650.
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5.2.1.9. Preview Simulation

You can view the profiles for the Piston, Intake Valves, Exhaust Valves and Mesh Refinement during the
simulation by selecting Preview Simulation > Boundary Motion > Simulation Preview. This is an excellent
way to check whether you have valve overlap and that the settings are correct.

As a method for checking the automatically generated mesh, you can generate a Preview Mesh. Select

Preview Simulation > Mesh Generation and then click the New Automatic Mesh Plot icon, name
this new automatic mesh generation plot “FTDC”, select Crank Angleas theTime Optionand set it to

720 CA. Then click Apply to save the settings and then on the Generate Mesh  icon. ANSYS Forte
will generate the preview mesh and display it in the 3-D View window. It is a good practice to look at
meshes at key points in the cycle such as Firing Top Dead Center (FTDC), Exhaust Valve Opening (EVO),
Intake Valve Closed (IVC), Intake Valve Open (IVO) and Exhaust Valve Closed (EVC). If you want to see
the cut plane where the mesh will be generated, click the Plane Filter box and specify an origin point
and normal direction for the cut plane.

Use the information in the following list to set up these New Automatic Mesh Plots.

1. FTDC @ CA=720: Point (X=0.0cm, Y=0.0cm, Z=0.0cm); Normal (X=0.0cm, Y=1.0cm, Z=0.0cm)

2. EVO @ CA=192: Point (X=0.0cm, Y=2.0cm, Z=0.0cm); Normal (X=0.0cm, Y=1.0cm, Z=0.0cm)

3. IVC @ CA=601: Point (X=0.0cm, Y=-2.0cm, Z=0.0cm); Normal (X=0.0cm, Y=1.0cm, Z=0.0cm)

4. IVO @ CA=363: Point (X=0.0cm, Y=-1.0cm, Z=0.0cm); Normal (X=0.0cm, Y=1.0cm, Z=0.0cm)

The visibility of the Automatic Mesh Plots is controlled in the Visibility tree under Preview Simulation
and Mesh Generation.

5.2.1.10. Run Simulation

To complete the lesson, select Run Simulation on the Workflow tree and, once ANSYS Forte displays
the green START button on the Run Simulation panel and reports a “Ready” status, click Start. You can

monitor the results by clicking on the Monitor Runs  icon. In the Monitor window that opens, you
can select the run you wish to monitor.

5.2.1.11. Run Settings

The settings here depend on the system and environment for your simulations. The default for the Run
Settings panel is to have nothing selected.

Run Options: This tutorial does not require changes to this panel’s defaults; adjust them as necessary
for your environment.

Windows Settings: This tutorial does not require changes to this panel’s defaults; adjust them as ne-
cessary for your environment.

Linux Settings: This tutorial does not require changes to this panel’s defaults; adjust them as necessary
for your environment.
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5.2.2. Results

To view the results of the simulation, open the Visualizer from the ANSYS Forte Launcher. In Visualize,
open the solution file for the case (Nominal.ftres). Figure 5.5: Screen view of the solution file in Visual-
ize. (p. 53) shows the screen view once the solution file has been loaded. Use Edit > Edit Preferences
to set the units for pressure to bar.

Figure 5.5:  Screen view of the solution file in Visualize.

Line plots can easily be created using the Line Plot Wizard. We will use the Line Plot Wizard and select
the X and Y Variables to Crank Angle and Net HRR, respectively. We will add the Pressure after the
initial line plot is created. Make sure that Average is selected at the top of the dialog box. On the lower
left you will see the drop-down menu for the Y Variable. Multi-select (control-click) the Pressure
Variable and it will display in the graph on a second Y-axis. The pressure and net heat release rate are
shown in Figure 5.6: Pressure (blue line) and Net Heat Release Rate (red line). (p. 54). The NOxand CO

emissions index (g/kg-fuel) during the cycle are shown in Figure 5.7: NOx and CO emissions index (g/kg-
fuel). (p. 54). Another interesting feature is to use the Iso-Contour Wizard to track the flame front across
the cylinder volume, as shown in Figure 5.8: Iso-contours at 1000 K showing the progression of the
flame front from CA 694-702 degrees. (p. 55). Use a temperature value of 1000 K for this purpose.
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Figure 5.6:  Pressure (blue line) and Net Heat Release Rate (red line).

Figure 5.7:  NOx and CO emissions index (g/kg-fuel).
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Figure 5.8:  Iso-contours at 1000 K showing the progression of the flame front from CA 694-702
degrees.
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Chapter 6: Tracking Soot Particles Evolution in a Diesel Engine

This tutorial presents the soot particle tracking capability in ANSYS Forte, applying the method of mo-
ments to a diesel engine case. With the soot particle tracking feature, several spatially resolved values
of soot can be simulated, including particle number density, volume fraction and average diameter.
The tutorial explains the setup for using the particle tracking capability, and presents visualizations of
soot predictions.

6.1. Data Provided

6.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select the Forte tutorials you wish to download. The file for this tutorial is:

• Soot-particle-tracking__tutorial.ftsim: A project file of the completed tutorial, for verification or comparison
of your progress in the tutorial set-up. The project file includes all the relevant geometry, chemistry set and
spray profile details.

The tutorial sample file is provided as a download. You have the opportunity to select the location for
the file when you download and uncompress the sample files.

Note

This tutorial is based on a fully configured sample project that contains the tutorial project
settings. The description provided here covers the key points of the project set-up but is not
intended to explain every parameter setting in the project. The .ftsim file has all custom and
default parameters already configured; the text highlights only the significant points of the
tutorial.

6.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your preferred diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.
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6.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take approximately 6.5 hours on

an Intel® processor E5-2690 at 2.90 GHz (8 total cores).

6.1.4. Prerequisites for This Tutorial

We recommend starting with the Forte Quick Start Guide , which explains the workflow of the ANSYS
Forte user interface, before doing this tutorial.

6.2. Project Setup

The Soot-particle-tracking__tutorial.ftsim project file has been preconfigured with all the information
that will be discussed in this section. You do not need to input any values but can just follow along,
reading the instructions and viewing the settings in the loaded .ftsim. This chapter nevertheless explains
step-by-step the process of setting up the project, as an illustration of the features in the user interface.

Open the project file, Soot-particle-tracking__tutorial.ftsim, from the location where you stored the
downloaded tutorial files.

6.2.1. Sector Mesh Details

A simple engine configuration is used in this tutorial for demonstration purposes. The details of the
configuration and simulation settings are presented in Table 6.1: Details of the diesel engine geometry
used in this tutorial (p. 58).

Table 6.1:  Details of the diesel engine geometry used in this tutorial

15Compression ratio

785Displacement volume (cm3)

45Sector angle

10Bore (cm)

10Stroke (cm)

0.1Squish (cm)

1.5, 6Flat piston bowl depth, diameter (cm)

0.1, 1.8Crevice width and height (cm)

The bowl profile used in the Sector Mesh Generator is described in Table 6.2: Details of the bowl profile
in the ANSYS Forte profile editor (p. 58).

Table 6.2:  Details of the bowl profile in the ANSYS Forte profile editor

Column 2 Distance (cm)Column 1 Distance (cm)

03

-1.53

-1.50

The 45° sector mesh was created using the Sector Mesh Generator in ANSYS Forte. The values described
in Table 6.1: Details of the diesel engine geometry used in this tutorial (p. 58) can be accessed in the

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.58

Tracking Soot Particles Evolution in a Diesel Engine



Soot-particle-tracking__tutorial.ftsim project file, by launching the Sector Mesh Generator, as shown
in Figure 6.1: Sector Mesh Generator settings for this tutorial. (p. 59). In the Sector Mesh Generator,
Topology 3 was deemed the most appropriate to represent this piston bowl geometry. The mesh
parameters for this topology were selected as follows:

1. ~1.2 mm resolution along the radial direction.

2. 3° along the azimuthal direction.

3. Along the z-direction:

• 0.8 mm in the piston bowl, to capture spray and events close to TDC accurately.

• 2 mm resolution in the squish region. Four minimum cells will be present, as specified in the Mesh
Controls Editor panel, to ensure resolution close to TDC. Away from TDC, the mesh is set to be coarse in
the squish region, for the sake of faster simulation in this simplistic demonstration case.

These settings resulted in a sector mesh with 38,490 cells when the piston is at bottom dead center
(BDC).

Figure 6.1:  Sector Mesh Generator settings for this tutorial.

In the Mesh Controls > Remeshing Editor panel, theSmoothcheck box is unchecked. All other controls
are left at default values.
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6.2.2. Chemistry Set Details

On the Models > Chemistry Editor panel, the Diesel_3comp_243sp__soot-particle-tracking.cks chemistry
set has been selected.

Note

This chemistry set requires a special license feature; please contact your Account Represent-
ative if you are not able to load the chemistry set and you are interested in using the Particle
Tracking option in ANSYS Forte.

This chemistry set includes a gas-phase mechanism (Diesel_3comp_243sp__soot-particle-track-
ing_chem.inp), a surface mechanism file (surf_soot_chem.inp) and a thermodynamic data file (Dies-
el_3comp_243sp__soot-particle-tracking_therm.dat).

The gas-phase mechanism contains 243 species participating in 1756 reactions. This mechanism has
been generated for use with the 66.8/33.2 wt% n-decane/AMN diesel surrogate. It has reaction pathways
to accurately predict soot precursors needed for the surface soot mechanism, all the way from small
hydrocarbons such as acetylene to polycyclic aromatic species such as pyrene.

If you were to create your own chemistry set for use with particle tracking, the surface mechanisms
would have to conform to certain standards, as defined in the Chemkin Input Manual and Chemkin
Theory Manual. The soot surface mechanism that is part of this tutorial's chemistry set includes:

1. Soot nucleation through multiple pathways.

2. HACA- and PAH-based soot growth pathways.

3. Soot oxidation through O2 and OH.

6.2.3. Transport Property Settings

The default values are used in the Transport property panel. In the Transport > Turbulence panel, the
RNG k-epsilon model is used, with default values.

6.2.4. Spray Model Settings

Under Models > Spray model, the spray models, nozzle and fuel injection values have been set.

The nozzle-1 settings are provided in Table 6.3: Nozzle settings (p. 60).

Table 6.3:  Nozzle settings

Location

Global originReference frame

CylindricalCoordinate system

0.1 cmR

22.5 degreesq

11.8 cmA

Spray direction
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Location

Global originReference frame

SphericalCoordinate system

110 degreesq

22.5 degreesf

Nozzle size

150 micronNozzle diameter

The following spray models are being used in this project, with default ANSYS Forte settings:

1. KH droplet breakup model

2. RT droplet breakup model

3. Gas-jet

4. Vaporization model

5. Radius of influence droplet collision model

The diesel fuel was simulated using a 2-component surrogate consisting (1) of 66.8 weight% n-decane/33.2
weight% 1-methylnaphthalene. This particular surrogate was designed to model a European diesel fuel
with cetane number of 55. This surrogate has a threshold sooting index of 36, placing it on the higher
end of the typical diesel fuel sooting index. Table 6.4: Details of both nozzle (Nozzle-1) and fuel injection
(Injection-1) (p. 61) provides details of the nozzle and the fuel injection. These values are entered under
the Models > Solid Injector-1 node. Specifically, the nozzle location and spray direction inputs are set
on the Nozzle-1 Editor panel, and the fuel injection-related inputs are specified on the Injection-1 Editor
panel.

On the Solid Injector-1 panel, parcel specification has been set using the Number of parcels option. The
Injected parcel count has been set to 3000.

The Inflow Droplet Temperature has been set to 320 K.

Spray was initialized using the Constant Discharge Coefficient and Angle option. A Constant Discharge
Coefficient of 0.7 has been used, with a Constant Mean Cone Angle of 15°.

The nozzle and fuel injection specifications are provided in Table 6.4: Details of both nozzle (Nozzle-1)
and fuel injection (Injection-1) (p. 61).

Table 6.4:  Details of both nozzle (Nozzle-1) and fuel injection (Injection-1)

Nozzle details

150 μmDirect-injector nozzle hole

140Direct-injector included angle (°)

Fuel injection details

-15Start of injection (° ATDC)

10Duration of injection (°)

1species names: n-decane is nc10h22; 1-methylnaphthalene is a2ch3.
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Nozzle details

30Total Injected mass (mg)

A slightly modified square profile: (0,0), (1E-7,1),
(0.999999,1), (1,0)

Injection velocity profile

6.2.5. Soot Model Settings

Under Models > Soot Model, choose Soot Model. There are three options for modeling soot in ANSYS
Forte. One option is to define a “pseudo-gas” soot model that is included in the gas-phase chemistry
mechanism input. In this case, you would not select Models > Soot Model. Otherwise, you may either
use a built-in 2-step model, which is one option on the Soot Model panel. Another option is the Method
of Moments. This option enables the particle tracking capability. In this tutorial, Method of Moments
is selected.

In this tutorial, with the Method of Moments option selected in the Soot Model panel, four inputs are
required. Details regarding these parameters can be found in the ANSYS Forte Theory Manual .

1. Number of Moments: 3-6 moments can be used in the simulations. Typically, it is recommended that 3
moments are sufficient; that value of 3 is used in this tutorial.

2. Scaling Factor for Moments: This value changes the units of the (internal) solution variable for particle
moments. A recommended value for typical problems is the default 1.0E+12, as the scaling helps preserve
the positivity of the solution during computation.

3. Scaling Factor for Surface Species: This value changes the units of the (internal) solution variable for
particle surface species. For example, setting it to 1.0E+12 results in pico-moles, while a value of 1 would
mean that the unit should be moles. A recommended value for typical problems is the default 1.0E+12,
as the scaling helps preserve the positivity of the solution during numerical computation.

4. Coagulation is included in this tutorial, with a Coagulation Collision Efficiency of 1.0. This coagulation
collision efficiency term is a combined correction factor to the coalescent collision between particles. The
van der Waals forces can enhance the collision frequency while non-coalescent collision can reduce the
frequency.

6.2.6. Boundary Conditions

Piston: The piston temperature is set to 500 K. The Law of the Wall model is used. Under Wall motion,
the Bore and Stroke values are set to 10 cm, and the Connecting Rod Length is set to 15 cm.

Periodicity: The Sector Angle is set to 45°.

Head: The Temperature is set to 470 K, and the Law of the Wall model is used.

Liner: The Temperature is set to 420 K, and the Law of the Wall model is used.

6.2.7. Initial Conditions

An ~20% EGR case is considered here. This results in an initial composition with a mass fraction of:

• O2=0.18

• N2=0.76
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• CO2=0.04

• H2O=0.02

The initial Temperature and Pressure are set to values of 450 K and 1.0 bar. The initial Turbulent

Kinetic Energy is set to 10,000 cm2/sec2, and the Turbulent Length Scale = 1 cm. Under Velocity,
Engine Swirl is chosen and an Initial Swirl Ratio of 1.0 is used. The Initial Swirl Profile factor is left at
the default value of 3.11.

6.2.8. Simulation Control

The simulation Start Crank Angle (i.e., Initial Crank Angle, under Simulation Controls in the Workflow
tree) is set to -130 degrees ATDC, the Engine Speed is specified as 2000 RPM, and the simulation Final
Simulation Crank Angle is set to +130 degrees ATDC.

6.2.9. Output Control

To allow visualizing fuel and soot precursor species, the following species have been named in the
Spatially Resolved and Spatially Averaged Output Control Editor panel. Also included in the list are
species for air, combustion products, and NOx.

1. Pyrene a4

2. Acetylene c2h2

3. Benzene c6h6

4. n-Decane, a fuel surrogate nc10h22

5. AMN, a fuel surrogate a2ch3

The spatially resolved values are output at intervals of 5 crank angles, and the spatially averaged values
every 1.0 crank angle.

6.3. Project Results

Spatially averaged plots appear below first, followed by some spatially resolved plots.

The simulation results for the pressure and heat release rate are shown in Figure 6.2: Calculated pressure
and heat release rate curves. (p. 64). The fuel ignites slightly after TDC.
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Figure 6.2:  Calculated pressure and heat release rate curves.

Figure 6.3: Predicted average particle diameter as a function of crank angle. (p. 64) shows a line plot of
the spatially averaged average particle diameter and total soot mass, as a function of crank angle. These
values are impacted by particle coagulation as well as by soot surface chemistry, including nucleation,
growth and oxidation. While the total soot mass decreases after ~10 CAD ATDC due probably to con-
sumption of soot by oxidation, the particle diameter increases until ~30 CAD ATDC due to a combination
of soot growth kinetics and particle coagulation. The average diameter peaks at around 20 nm for this
case.

Figure 6.3:  Predicted average particle diameter as a function of crank angle.

Figure 6.4: Average particle diameter iso-surface of 20 nm, as a function of crank angles. (p. 65) uses
iso-surfaces (50 nm) to show the spatially resolved values of average particle diameter, at 30-70 crank
angle degrees. Of the three crank angles explored here, the 20 nm particles peak at 50 CAD, and the
location of these relatively large particles is in the squish zone.
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Figure 6.4:  Average particle diameter iso-surface of 20 nm, as a function of crank angles.

Figure 6.5: Average particle size distribution at different crank angles. (p. 65) shows the average particle
size distribution. It can be seen that initially at 5-10 CAD, the particle count is high but the particle size
is low with the majority of particles being smaller than 4 nm. With increasing crank angle, the lower,
zoomed-in plot shows that larger diameter particles form but have lower particle count.

Figure 6.5:  Average particle size distribution at different crank angles.
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Chapter 7: Solving a Gasoline Direct Injection Engine Simulation

This tutorial describes how to use ANSYS Forte to simulate combustion in a direct injection spark ignition
internal combustion engine with moving valves. Engine geometry is imported and ANSYS Forte's
automatic mesh generation is used to create the computational mesh on-the-fly during the simulation.

7.1. Data Provided

This section describes the provided files, time required, prerequisites, and a utility for comparing your
generated project file (.ftsim) with the one provided in the tutorial download.

7.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select the Forte tutorials you wish to download. The files for this tutorial are:

• Forte_GDI_Tutorial.stl: This is the geometry file.

• exhaust_valve_lift.csv and intake_valve_lift.csv: Two files of data describing the intake and exhaust valve
lifts. Profiles such as these can be imported (from .csv files) or manually entered in the Profile Editor

• spatial_output.csv: Specifies when spatially resolved data such as velocity, temperature, species concentra-
tions, etc., will be output.

• Forte_GDI_Tutorial.ftsim: A project file of the completed tutorial, for verification or comparison of your
progress in the tutorial set-up.

The tutorial sample file is provided as a download. You have the opportunity to select the location for
the file when you download and uncompress the sample files.

Note

This tutorial is based on a fully configured sample project that contains the tutorial project
settings. The description provided here covers the key points of the project set-up but is not
intended to explain every parameter setting in the project. The .ftsim file has all custom and
default parameters already configured; the text highlights only the significant points of the
tutorial.

7.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

67
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

http://support.ansys.com/training
http://support.ansys.com/training


Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your favorite diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.

7.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take approximately 33.2 hours on

a cluster with 16 nodes of dual Intel® Xenon® processors E5-2690 at 2.90 GHz (8 cores).

7.1.4. Prerequisites for This Tutorial

We recommend starting with the Forte Quick Start Guide , which explains the workflow of the ANSYS
Forte user interface, before doing this tutorial.

7.2. Direct Injection Spark Ignition Engine

The next sections describe the problem, including how to set up the simulation that is represented in
the provided .ftsim file, and some results relating to surfaces, spray, and flame, that you can generate.

7.2.1. Problem Description

A three-dimensional single cylinder CFD simulation, of a four-stroke spray-guided Gasoline Direct Injection
(GDI) Spark Ignition (SI) engine, is performed in this tutorial. Detailed boundary conditions are shown
in Figure 7.1: Schematic of GDI engine (p. 68). Engine simulation is started from intake valve opening
(IVO) and fuel is injected during the intake stroke. Homogeneous fuel air mixture is compressed and
the spark ignited 15° before compression Top Dead Center (TDC).

Figure 7.1:  Schematic of GDI engine

This tutorial illustrates the following steps in setting up and solving a Gasoline Direct Injection combustion
simulation.

• Read an existing geometry into the Forte system.

• Define mesh setup and mesh the geometry.
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• Set up the injection event.

• Set up the spark timing event.

• Set up the boundary and initial conditions.

• Specify the simulation controls.

• Specify the output variables and frequency.

• Run the simulation.

• Examine the results in the report.

7.2.1.1. Import the Geometry

Note

All Editor panel options that are not explicitly mentioned in this tutorial should be left at
their default values. Changed values on any Editor panel do not take effect until you press
the Apply button. Always press the Apply button after modifying a value, before moving
to a new panel or to the Workflow tree.

In this tutorial, we will import an existing geometry into ANSYS Forte and set up the automatic mesh
generation using a global mesh size and adapting the mesh near the valves. The geometry used will
be half symmetric. To import the geometry, go to the Workflow tree and click Geometry. This opens
the Geometry icon bar. Click the Import Geometry

icon. In the resulting dialog, pull down and select Surfaces from STL file. Browse to and select the file
called Forte_GDI_Tutorial. In the dialog that opens with STL file import options, accept the defaults
for units and tolerances. Note that the geometry should always be in centimeters units when read into
Forte. If it is not, the geometry can be scaled using the appropriate scaling factor to get it into centi-
meters. Note that once you have imported the geometry, there are a number of actions that you can
perform on the items in the Geometry node, such as scale, rename, transform, invert normals, or delete
geometry elements.

Once the geometry is read in, you should see the following surfaces: liner, exhaust-port, inlet, outlet,
intake-port, piston, head, exhaust-valve, intake-valve, intake-symmetry, cylinder-symmetry, ex-
haust-symmetry, spark-plug.

The Geometry imports in an opaque mode and possibly preset zoom level. It is often helpful to Refit

the view or use the mouse wheel to re-zoom. To change opacity, right-click the Geometry node in the
right-side Visibility tree and select Medium for the Opacity level of all geometry elements, as shown in
Figure 7.2: Engine geometry with valves and ports defined (p. 70).
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Figure 7.2:  Engine geometry with valves and ports defined

7.2.1.2. Subvolume Creation

Subvolumes are useful to refine regions of interest, such as the chamber. The subvolume can then be
used in the mesh controls to control the size of the mesh in the selected subvolume. Select the following
surfaces to define the subvolume: cylinder-symmetry, head, liner, piston, and spark_plug. You should
see a triangulated region as in Figure 7.3: Subvolume for the chamber (p. 70).

Figure 7.3:  Subvolume for the chamber

7.2.1.3. Automatic Mesh Generation Setup

The Material Point is the point in the domain that tells ANSYS Forte where the mesh will be generated
and should be located at least one unit cell length away from any boundaries. This point must remain
inside of the domain throughout the entire simulation. Typically it is located near the head so it is still
inside the domain at TDC.

• Mesh Controls ¬ Material Point: Accept the default Reference Frame using the Global Origin. Set the
Location using Cartesian Coord. System to X = 0.25, Y = 3.25, and Z = 0.25 cm. ClickApply.

• From the Workflow tree, use Mesh Controls ¬ Global Mesh Size to set the Global Mesh Size to 0.2 cm.

Note

This is the recommended mesh size; a coarser setting of 0.3 cm could be used for tutorial
purposes to produce a shorter runtime.
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• Add a Solution Adaptive Mesh refinement: Click the Solution Adaptive Meshing  icon on the Mesh
Controls Editor panel, and name the new control SAM-Temperature. Set the Quantity Type = Gradient
of Solution Field and Solution Variables = Temperature. Bounds Option = Statistical and Sigma
Threshold = 0.5. Set the Size as fraction of Global Size = 1/4. The refinement is Active between Crank
Angle 700 and 800 degrees, and the Location option is Sub-Volumes = chamber. Click Apply.

• Click the Solution Adaptive Meshing  icon on the Mesh Controls Editor panel and name the new
control SAM-Velocity. Set the Quantity Type = Gradient of solution field and solution variable = Velo-
cityMagnitude. Bounds Option = Statistical and Sigma Threshold = 0.5. Set the Size as fraction of
Global Size = 1/2. The refinement is Active = Always, and the Location option is Entire Domain. Click
Apply.

• Accept the default setting for the Small Feature Deactivation Factor.

Next, you will refine the mesh around key geometric features such as valves and the piston, walls, and
open boundaries (“continuative outflows”). The following steps show how the mesh is refined for key
geometric features. From the Mesh Controls node, you can add Point, Surface, Line, or Feature Refine-
ments, or Small Feature Avoidance Controls. Create the refinements specified in Table 7.1: Details of
the refinement types and settings (p. 71). These are also good guidelines for the level of refinement
for your own engine simulations.

Table 7.1:  Details of the refinement types and settings

ActiveCell LayersSize FractionRefinement
Type

LocationName

Always11/2SurfaceCylinder
symmetry,

wall

exhaust-symmetry,
intake,
symmetry,
exhaust-port,
intake-port,
head, piston,
liner,
spark-plug

Always21/2SurfaceInlet, outletwall

AlwaysN/A1/4Point (radius =
0.6 cm)

0.551, 0.0945,
-0.1678 cm

spark

Always21/4Surfaceexhaust-valve,
intake-valve

valves

340-380 CA21/4Surfacehead, piston,
liner

tdc1

700-740 CA21/4Surfacehead, piston,
liner

tdc2

AlwaysN/A1/2Secondary
volume

Chamberchamber
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7.2.1.4. Models Setup

Chemistry: Now that the mesh has been set up, assigning models is next. Assign the chemistry with
Models ¬ Chemistry and use the Import Chemistry

icon and select the file Gasoline_1comp_59sp.cks from the ANSYS Forte data directory. If you are
curious, you can view the chemistry details, such as chemistry source, pre-processing log, gas phase
input, gas phase output, thermodynamic input, transport input, and transport output.

• Flame Speed Model: Use Models ¬ Chemistry ¬ Flame Speed Model and select the Table Library Option.
Select Create New, then add ic8h18 as the fuel species and specify ic8h18_flame_library as the name. For
the Turbulent Flame Speed settings, keep the defaults except for Turbulent Flame Speed Ratio (b1),
which should be set to 1.2. Click Apply.

Transport: The default RNG k-epsilon model turbulence settings are used in this tutorial. Those are
specified in the Editor panel for Models ¬ Transport ¬ Turbulence. The default fluid properties are also
used, which are at Models ¬ Transport.

Spray Model: Turn on the spray model by checking the box at Models ¬ Spray Model. For Spray mod-
eling in Forte, you will create an Injector first, then and Injection events and Nozzles to the injector.
You can have multiple injectors in a Forte model and they can have different fuels.

Create a new Solid Cone Injector

and name it Solid Injector. Specify the following for the injector:

• For Composition, select Create New… then select ic8h18 as the fuel species and specify the mass fraction
as 1.0. Specify gasoline as the name and click Save.

• Set Injection Type to Pulsed Injection and Parcel Specification to Droplet Density with a Droplet
Number Density of 1.

• Set the Inflow Droplet Temperature to 400K.

• For Spray Initialization, select Constant Discharge Coefficient and Angle and specify the Discharge
Coefficient as 0.7 and the Mean Cone Angle as 14.0 degrees.

• Select Rosin-Rammler Distribution for the Drop Size Distribution, use 3.5 for the Shape Parameter and
specify the Initial Sauter Mean Diameter as 120 micron.

• Specify the following for the KH and RT model constants:

– Size Constant of KH Breakup = 0.5

– Time Constant of KH Breakup = 10

– Critical Mass Fraction for New Droplet Generation = 0.03

– Activate the SMR Conservation in KH Breakup option (Note: This option is typically activated for gasoline
injections, but not for diesel injections.)

– Size Constant of RT Breakup = 0.1
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– Time Constant of RT Breakup = 1.0

– RT Distance Constant = 1.9

– Activate the Use Gas Jet Model and specify 0.5 for the Gas Entrainment Constant.

Now add an Injection by clicking the Injection

icon at the top of the Injector Editor panel or by right-clicking on the Solid Injector and selecting Add
> Injection. Specify the Injection Type as Pulsed and the Timing as Crank Angle. Specify the Start
of injection as 420 degrees and the Duration as 18.4 degrees.

For the Velocity Profile, select Create New…, the click the Load CSV button. Browse to the directory
containing the tutorial files and select the file called injection_profile.csv. Clear the Read Column Titles
option as shown in Figure 7.4: Import injection profile from CSV dialog (p. 73).

Figure 7.4:  Import injection profile from CSV dialog

The profile should look like the image in Figure 7.5: Injection profile after import (p. 74) after import.
Specify roi_profile as the profile name.
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Figure 7.5:  Injection profile after import

Now that the injection event has been added, we need to specify the nozzles. The nozzles require input
for the location, direction, and nozzle hole diameter (or area). Since this is a half-symmetry model, three
nozzles will be specified.

On the Solid Injector panel, click the New Nozzle

icon or right-click Solid Injection and click Add > Nozzle. Name the new nozzle nozzle1.

For the Location, specify X = -5.296mm, Y = 0.634mm, and Z = 6.468mm and for Spray Direction
specify X = 3.0415mm, Y = 2.73735mm, and Z = -9.12449mm. For the Nozzle Size, select the Diameter
option and specify a nozzle diameter of 300 micron.

Now that the first nozzle has been created, copy and paste nozzle1 and name it nozzle2 using the
Copy

and Paste

icons. For the Location, specify X = -5.65mm, Y = 1.1885mm, and Z = 6.5991mm and for Spray Dir-
ection specify X = 1.49781mm, Y = 5.08692mm, and Z = -8.4782mm.

Repeat the copy and paste process by copying nozzle2 and naming it nozzle3 to create the last nozzle.
For the Location, specify X = -6.7647mm, Y = 0.72441mm, and Z = 6.1653mm and for Spray Direction
specify X = -2.90254mm, Y = 2.74977mm, and Z = -9.16592mm.

Now that all the nozzles have been created, they should appear similar to the model in Figure 7.6: Nozzles
after specifying location and orientation (p. 75).

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.74

Solving a Gasoline Direct Injection Engine Simulation



Figure 7.6:  Nozzles after specifying location and orientation

Spark Ignition: Turn on the spark ignition model by checking the box at Models ¬ Spark Ignition.

The spark ignition model defaults include a Kernel Flame to G-Equation Switch Constant of 2.0, Min.
Kernel Radius for Kernel to G-equation switch of 0.1cm, Flame Development Coefficient of 0.5,
and Number of Flame Particles for Each Spark Plug of 3000.

Use the New Spark

icon to create a new spark event and name it Spark.

Use Models ¬ Spark Ignition ¬ Spark to set up the details of the spark event. In the Reference Frame,
use Global Origin and Cartesian coordinates for the Location, and set X= 0.551 cm, Y=0.0945 cm,
and Z=-0.1678 cm. Select Crank Angle for Timing and Starting Angle = 705.0 degrees, Duration =
10.0 degrees. Under Spark Energy, set Energy Release Rate = 20.0 J/sec. Accept the default 0.5 for
Energy Transfer Efficiency and 0.25 mm (note that the unit is mm) for Initial Kernel Radius. Click
Apply.

7.2.1.5. Boundary Conditions

Boundary conditions are specified for each of the geometry elements in Boundary Conditions ¬ geometry-
element-name, where geometry-element-name is each of the items under Geometry in the Workflow
tree.

Inlet: From the Boundary Conditions node, click the New Inlet  icon and create an Inlet. Select
Pressure_In from the Location list. Select Pressure Inlet as the Inlet Type with a constant pressure
of 8E+04 Pa. You will set the inlet composition to the correct Mass Fraction values corresponding to
the premixed fuel and air:

• o2=0.233

• n2=0.767

To do this, select Create New in the Composition drop-down list above the Location list and click the

Pencil  icon. This opens the Gas Mixture panel, where you select Add Species and then choose the
species you want from the mechanism (see Figure 7.7: Gas Mixture Editor: Defining inlet gas composi-
tion (p. 76)). You can find a species more quickly by typing (the beginning of ) the species name to filter
the list. Save the inlet gas mixture as air. You will then see a list to define turbulence using Turbulent
Kinetic Energy and Length Scale of 10000 cm2/sec2 and 1 cm, respectively.
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Figure 7.7:  Gas Mixture Editor: Defining inlet gas composition

Outlet: From the Boundary Conditions node, click the New Outlet  icon and create Outlet. Select
the Pressure_Out geometry item and select the Pressure Outlet as the Outlet Type. Give the outlet
a Pressure of 1E+05 Pa, which arises from the back-pressure of the exhaust system with an Offset
Distance to Apply Pressure of 0.0 cm. Set the Turbulence Boundary Conditions to Turbulent Kinetic
Energy and Length Scale of 10000 cm2/sec2 and 1 cm, respectively.

Piston: From the Boundary Conditions node, click the New Wall  icon and name it Piston. Select
the Piston item in the Location list. Set the Temperature Option to Constant and 485 K. Turn ON
the Wall Motion option and set the piston Motion Type to use a Slider-Crank Model with a Stroke
of 9.0 cm and a Connecting Rod Length of 14.43 cm with 0.0 Piston Offset. Change the Movement
Type to Moving Surface and accept the default Global Origin Reference Frame. For Direction, the
piston will move along the Z-direction, specify 1.0 for Z.

Intake: Click the New Wall  icon and name it intake-port. Select the intake-port item in the Location
list and set the Temperature to 313 K.

Exhaust: Click the New Wall  icon and name it exhaust-port. Select the exhaust-port item in the
Location list and set the Temperature to 485 K.

Liner: Click the New Wall  icon and name it liner. Select the liner item in the Location list and set
the Temperature to 500 K.
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Head: Click the New Wall  icon and name it head. Select the head item in the Location list and set
the Temperature to 485 K.

Intake Valves: Click the New Wall  icon and name it intake-valve. The valve specification is a little
more complicated than the stationary walls, such that several steps are required within the wall panel.
These steps specify the wall motion and the way we want the mesh to adapt to the gap opening near
the valve seat when the valve opens or closes.

• Select the intake-valve in the Location list.

• Check the Heat Transfer option and set the Temperature to the constant value of 400 K.

• Turn ON (check) the Wall Motion and set the Motion Type to Offset Table.

• Accept the default Global Origin for the Reference Frame. Select Cartesian for the Coord. System under
Direction for the valve motion and set X = 0.241922 cm, Y = 0.0 cm, Z = −0.970296 cm.

• To import the lift profile (named intake_valve_lift.csv in the same location as the .stl file you started this
tutorial with), select Create New from the Lift Profile drop-down list and click the Pencil

icon. In the Profile Editor, click the Load SV button and navigate to the intake_valve_lift.csv file. Clear the
Read Column Titles option and press OK. At the bottom of the Profile Editor window, name this in-
take_valve_lift. Ensure that the units in the first column are set to Angle and the second column for Distance
is set to m. Save the Profile.

• For Movement Type, change the pull-down menu to Valve. Then select just the surface boundary portion
of the valve that comes into contact with the valve seat on the head, as well as the surface boundary that
contains the seat region. In this case, select both the head and the intake-valve.

• Finally, set the Valve Motion Activation Threshold to 0.02 cm. This indicates that the valve will not open
until the lift value specified in the valve-lift profile exceeds this threshold. A smaller value will cause the
valves to open sooner, but the mesh refinement required to resolve the gap will be higher. This is a trade-
off that will need to be determined based on the goals and outcomes desired from the simulation. In addition
to the activation threshold, you may also change the minimum number of cells desired at the smallest gap
opening. In this case, specify the Approx. Cells in Gap at Min. Lift as 1.5.

Exhaust Valves: Click the New Wall  icon and name it exhaust-valve. New Wall  icon and name
it exhaust-valve. Follow a similar procedure as for the Intake Valves. This time, select the exhaust-valve
item in the Location list and set the Temperature to 777 K Turn ON the Wall Motion and set the
Motion Type to Offset Table and the Vertices to Transform to Interior. Select Global Origin for the
Reference Frame. Select Cartesian for the Coord. System under Direction and set X = -0.327218 cm,
Y = 0.0 cm, and Z = -0.944949 cm. Similarly to the intake valves, first import the .csv (named ex-
haust_valve_lift.csv) file, clear the Read Column Titles option, and name it exhaust_lift_profile. Then
follow the same procedures for specifying the Movement Type to Valve, selecting the Valve Seat and
Surface it Contacts (exhaust-valve and head), and setting the Valve Motion Activation Threshold
to 0.02 cm. Specify the Approx. Cells in Gap at Min. Lift as 1.5.

Symmetry: Click the New Symmetry  icon and name it symmetry. Select the cylinder-symmetry,
exhaust-symmetry, and intake-symmetry item in the Location list.

77
Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Direct Injection Spark Ignition Engine



Spark Plug: Click the New Wall  icon and name it exhaust-valve. New Wall  icon and name it
spark-plug. Select the head item in the Location list and set the Temperature to 485 K.

7.2.1.6. Initialization

The domain is initialized with the operating conditions, species concentrations and temperatures. The
Default Initialization species composition is at the expected exhaust composition, assuming complete
combustion. The intake and exhaust must also be initialized to the boundary condition values. Set the
following initialization parameters:

Default Initialization:

• Select Default Initialization in the Workflow tree. Set the Initialization Order to 2. Since flow goes generally
from the intake to the cylinder and then to the exhaust, this indicates that this default (cylinder) region will
be the second in the initialization order precedence list.

• We will use the Forte Composition Calculator to compute the exhaust gas composition. Click the Composition
Calculation button

in the Toolbar or go to Utility > Composition Calculation. In the Composition calculation, specify the Fuel
Mass (27 mg), select the fuel mixture in the Liquid input, for Air Flow specify Phi and set Phi = 1.0, EGR
Fraction = 0.0, and for Internal EGR select the Estimate from CR and specify a CR of 10. Next, set the
Calculate option to Exhaust and click Create Mixture. Specify a name of exhaust_gas. In the Initial Condi-
tions, select exhaust_gas for the Composition.

• Set a Temperature of 1,070 K and the Pressure to 1.05359E+05 Pa.

• The Turbulence initialization uses the Turbulent Kinetic Energy and Length Scale option with values
10,000 cm2/sec2 and 1.0 cm, respectively.

• The Velocity is initialized using Velocity Components and all the values are set to zero.

• Click Apply.

Intake Initialization: The intake manifold Initial Condition is set to match the Boundary Condition at
the Inlet. Since this is a separate port that can be closed off from the main cylinder region, we also
need to set the equivalent of a material point to identify the region, as well as an initialization order
that helps determine what region takes precedence in initializing new cells that appear when gaps are
opened.

• From the Initial Conditions Workflow tree item, select the New Port Initialization

icon and name it intake.

• To identify the region, select a point for the Location under the Reference Frame selection, which is a point
that will always be within the Intake port. Set the coordinates for this case to X=-5.6838, Y=1.4295,
Z=4.2858 cm, which is a point just inside the inlet.

• Set the Initialization Order to 1. Flow is expected to go from the intake to the main region; for this reason,
we give it the first order in initialization precedence.

• Set the Composition by selecting in the previously saved profile, air. Set the Temperature to 313 K and
Pressure to 8.0E+04 Pa. The Turbulence initialization uses Turbulent Kinetic Energy and Length Scale
option set to 10,000 cm2/sec2 and 1.0 cm, respectively. Click Apply.
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Exhaust Initialization: The Initial Condition of the Exhaust is set to match the Boundary Condition of
the Outlet.

• From the Initial Conditions Workflow tree item, select the New Port Initialization

icon and name it exhaust.

• To identify the region, select a point for the Location under the Reference Frame selection, which is a point
that will always be within the ExhaustPort region. Set the coordinates for this case to X=4.7892, Y=1.5061,
Z=3.1552 cm, which is a point just inside the outlet.

• Set the Initialization Order to 3. Flow is expected to go from the cylinder to the exhaust port; for this
reason, we give it the last order in initialization precedence for the 3 regions defined.

• Set the Composition to the existing profile, exhaust_gas. Set the Temperature to 1070K and Pressure
to 1.0E+05 Pa.

• The Turbulence initialization uses the Turbulent Kinetic Energy and Length Scale option; these are set
to 10,000 cm2/sec2 and 1.0 cm, respectively. Click Apply.

7.2.1.7. Simulation Controls

Simulation controls allow you to define the simulation limits, RPM, time step, chemistry solver, and
transport terms.

Simulation Limits: Use the Simulation Controls panel to select a Crank Angle- based simulation from
a CA of 328 to 880.2 degrees. Set RPM = 2,000 rpm. The engine Cycle Type is 4-Stroke.

Time Step: Use Simulation Controls ¬ Time Step and set the following parameters:

• Initial Simulation Time Step to 5.0E-7 seconds

• Max. Crank Angle Delta Per Time Step of 1.1 degrees

• Set the Max. Time Step Option to Constant and set the value of Max. Simulation Time Step to 1.E-5 sec.
The time step will be adaptively determined throughout the simulation, based on local solution gradients,
so this just sets the maximum value allowed. You may also consider reducing the time-step using the Time
Varying option. This can be helpful for injection and spark events.

The Advanced Time Step Control Options settings are kept at the defaults:

• Time Step Growth Factor = 1.3

• Fluid Acceleration Factor = 0.5

• Rate of Strain Factor = 0.6

• Convection factor = 0.2

• Internal Energy Factor = 1.0

• Max. Convection Subcycles = 8

Chemistry Solver: Simulation Controls ¬ Chemistry Solver is also kept at the defaults, with the following
parameters:
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• Absolute Tolerance = 1.0E-12

• Relative Tolerance = 1.0E-5

• Use Dynamic Cell Clustering to take advantage of groups of cells with similar conditions. Select 2 features
to introduce Dynamic Cell Clustering: 1) Max. Temperature Dispersion of 10 K and 2) a Max. Equilibrium
Ratio Dispersion of 0.05.

• To increase the time-to-solution speed, you have the ability to choose when chemistry is activated. In this
tutorial, select Activate Chemistry Conditionally, turn on (check) After First Spark Event, and select When
Temperature is Reached with Threshold Temperature 600 K and also select During Crank Angle Interval
between 670 and 850 Crank Angle. This ensures that chemistry is active during the time that combustion
is expected even if temperature does not rise above 600 K. Click Apply.

Transport Terms: Use the default transport tolerances and maximum number of iterations.

7.2.1.8. Output Controls

Output controls determine what data are stored for viewing during the simulation and for creating
plots, graphs, and animations in ANSYS Forte Visualize, CFD-Post, EnSight, or FieldView.

Spatially Resolved: Allows you to control when spatially resolved data such as velocity, temperature,
species concentrations, etc., will be output. In the Spatially Resolved panel, set the Crank Angle Output
Control to report every 10 degrees (to manage the size of the output file). You can optionally increase
the frequency of output during the cycle by selecting User Defined Output Control and importing
the spatial_output.csv file, which has a list of specific crank angles where spatially resolved output will
occur. Alternatively, you could select User Defined Output Control, and use the Profile Editor to create
some other file specifying an output crank-angle profile (the provided profile is illustrated in Figure 7.8: Pro-
file of spatially resolved output control data (p. 80)). Keep the default species and solution variables
selected for output. Reducing the variables selected will help reduce file sizes.

Figure 7.8:  Profile of spatially resolved output control data
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Spatially Averaged: Allows you to control the output of values that are averaged across the domain.
On the Spatially Averaged panel, set the Crank Angle Output Control to reporting every 1 degree.
Keep the default species and solution variables selected for output.

Restart Data: If you anticipate that the case will be stopped and you want the ability to restart it from
the last time step solved, select Output Controls ¬ Restart Data. You can specify certain Restart Points
using a separate file. Turn on (check) User Defined Restart Points and use the Profile Editor to create
a Restart profile. You can view, edit, or import new Restart Points in this 1-D Profile Editor. Sometimes
it is helpful in spark ignition cases to save a restart file after IVC but before the spark occurs (CA=687
in this case) so you can use the compression portion of the cycle as a start point in additional runs.
Create a new profile for this purpose called restart_output and add two lines with CA value set to 415
and 700 which correspond to points just before injection and spark timing.

7.2.1.9. Preview Simulation

You can view the profiles for the Piston, Intake Valves, Exhaust Valves, and Mesh Refinement during
the simulation by selecting Preview Simulation > Boundary Motion > Simulation Preview. This is an
excellent way to check whether you have valve overlap and that the settings are correct.

As a method for checking the automatically generated mesh, you can generate a Preview Mesh. Select

Preview Simulation ¬ Mesh Generation and then click the New Automatic Mesh Plot  icon, name
this new automatic mesh generation plot 720CA, select Crank Angle as the Time Option and set it to
720 CA, specify the Normal by setting Y = 1.0. Then click Apply to save the settings and then on the

Generate Mesh  icon. ANSYS Forte will generate the preview mesh and display it in the 3-D View
window. It is a good practice to look at meshes at key points in the cycle such as Firing Top Dead
Center (FTDC), Exhaust Valve Opening (EVO), Intake Valve Closed (IVC), Intake Valve Open (IVO) and
Exhaust Valve Closed (EVC). If you want to see the cut plane where the mesh will be generated, click
the Plane Filter box and specify an origin point and normal direction for the cut plane.

7.2.1.10. Run Simulation

To complete the lesson, select Run Simulation on the Workflow tree and, once ANSYS Forte displays
the green START button on the Run Simulation panel and reports a “Ready” status, click Start. You can

monitor the results by clicking on the Monitor Runs  icon. In the Monitor window that opens, you
can select the run you want to monitor. Open the Forte Monitor dialog, then select Pressure under the
thermo.csv grouping. The pressure trace should look like the one in Figure 7.9: Pressure trace result
from Forte (p. 82).
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Figure 7.9:  Pressure trace result from Forte

7.2.1.11. Run Settings

The settings here depend on the system and environment for your simulations. The default for the Run
Settings panel is to have nothing selected.

Run Options: Under Job Script Options, change Default Run Type to Parallel and change the default
MPI Arguments to 8. (If you do not have MPI installed and configured, keep the default of a serial run.)

Windows Settings: Under Job Script Options, change Default Run Type to Parallel.and change the
default MPI Arguments to 8. (If you do not have MPI installed and configured, keep the default of a
serial run.).

Linux Settings: This tutorial does not require changes to this panel’s defaults; adjust them as necessary
for your environment.

7.2.2. Results

To view the results of the simulation, open the results in CFD-Post. In CFD-Post, open the solution file
for the case (Nominal.ftind). Figure 7.10: Screen view of the solution file in CFD-Post (p. 83) shows the
screen view once the solution file has been loaded.
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Figure 7.10:  Screen view of the solution file in CFD-Post

Once you have read in the model, you can create surface groups to group the surfaces. In this case, we
will create a surface group for the spark plug, walls, symmetry boundaries, and the valves. To create a
surface group, right-click User Locations and Plots Insert > Locations > Surface Group and specify
the name symmetry. On the Geometry tab, select the surfaces names cylinder symmetry, exhaust
symmetry, and intake symmetry and click Apply as in Figure 7.11: Creating surface groups in CFD-
Post (p. 84).
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Figure 7.11:  Creating surface groups in CFD-Post

On the Color tab, choose gray as the color. On the Render tab, specify a Transparency of 0.5. Repeat
these steps create the following surface groups:

TransparencyColorSurface SelectionsSurface Group
Name

0.5OrangeSpark plugSparkplug

0.5OrangeIntake valve, exhaust valveValves

0.5GrayExhaust port, head, inlet, intake port, liner, outlet, pistonWalls

To visualize the spray particles, turn on the Spray object in the list as in Figure 7.12: Turning on the
spray particles (p. 85).
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Figure 7.12: Turning on the spray particles

When the spray is activated, all the particles will be a single color. You can use a variable to change
the color by going to the Color tab. Set the Mode to Variable and select Spray Particle Radius. You
can also adjust the droplet size rendering on the Symbol tab; a value of 0.3 works well for this case.
Go to Tools > Timestep Selector and select crank angle 436CA. With these changes, the spray should
resemble Figure 7.13: Spray particles in the combustion chamber (p. 86).
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Figure 7.13:  Spray particles in the combustion chamber

You may also want to visualize the location of the flame front for spark ignited engines. This can be
accomplished by creating an Iso-Surface for variable G and setting the value to 0.0. Right-click User
Locations and Plots > Location and select Iso-Surface. Name the surface flame. For Variable, select
G and specify a value of 0.0. On the Color tab, set Mode to Constant and choose a red color. Go to
Tools > Timestep Selector and choose a time step after spark timing, for example, 728CA, and you
should see the flame location, as in Figure 7.14: Iso-surface of the flame showing the flame location at
728CA (p. 87).
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Figure 7.14:  Iso-surface of the flame showing the flame location at 728CA

Note

A CFD-Post state file (Forte_GDI_Tutorial_PostProcessing.cst) is included with this tutorial
that will create all the settings discussed in the post-processing section.
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Chapter 8: Two-Stroke Engine Simulation

This tutorial describes how to use ANSYS Forte CFD to simulate combustion for a two-stroke marine
engine with intake and exhaust ports. Details on how to use ANSYS Forte's automatic mesh generation
with sliding interfaces, a requirement for 2-stroke engines, is discussed. The tutorial also demonstrates
profile creation and the import and loading of an .stl file to start the simulation from the geometry.

8.1. Data Provided

The following sections describe the provided files, time required, prerequisites, and a utility for comparing
your generated project file (.ftsim) with the one provided in the tutorial download.

8.1.1. Files Used in This Tutorial

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

and select the Forte tutorials, and the desired files to download. The files for this tutorial include:

• FORTE-2stroke .ftsim:A project file of the completed tutorial, for verification or comparison of your progress
in the tutorial set-up. The project file includes all the relevant geometry, chemistry set, and spray profile
details.

• intake_pressure_profile.csv and exhaust_pressure_profile.csv: Two files of data describing the profile of
the time-varying pressure for the intake and exhaust.

• time_step_size.csv: Adaptive time-step profile.

• output_crank_angles.csv: Profile of crank-angle points for spatially resolved output.

• FORTE_2stoke.stl: Geometry file for the 2-stroke engine in this project without the chemistry set, spray
profile, and other project details. (Optional)

• restart_crank_angles.csv: Profile defining restart points. (Optional)

• Nom-VelMag_Vector-Centerline.avi: An animation showing the velocity magnitude and piston motion of
the meshed system. (Optional)

The tutorial sample file is provided as a download. You have the opportunity to select the location for
the file when you download and uncompress the sample files.

Note

This tutorial is based on a fully configured sample project that contains the tutorial project
settings. The description provided here covers the key points of the project set-up but is not
intended to explain every parameter setting in the project. The .ftsim file has all custom and
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default parameters already configured; the text highlights only the significant points of the
tutorial.

8.1.2. Project Comparison Utility

The Forte installation includes the cgns_util export command, which you can use to compare the
parameter settings in the project file generated at any point during your tutorial set-up against the
provided .ftsim , which has the parameter settings for the final, completed tutorial. This command is
described in the Forte User Guide.

Briefly, you can double-check project settings by saving your project and then running the cgns_util
to export your tutorial project, and then to export the provided final version of the tutorial. Save both
versions and compare them with your favorite diff tool, such as DIFFzilla. If all the parameters are in
agreement, you have set up the project successfully. If there are differences, you can go back into the
tutorial set-up, re-read the tutorial instructions, and change the setting of interest.

8.1.3. Time Estimate

As a guideline for your own simulations, this tutorial is estimated to take approximately 9.5 hours on

an Intel® Xenon® processor E5-2690 at 3.00 GHz (20 total cores).

8.1.4. Prerequisites for This Tutorial

We recommend starting with the ANSYS Forte Quick Start Guide , which explains the workflow of the
ANSYS Forte user interface, before doing this tutorial.

8.2. Two-Stroke Marine Engine Project Setup

The next sections describe the problem, including how to set up the simulation that is represented in
the provided .ftsim file, and some results relating to surfaces, spray, and flame, that you can generate.

8.2.1. Problem Description

In this case, a full 3-D geometry is used to simulate a 2-stroke marine engine, including combustion.
The fuel in this engine is gasoline and is direct-injected into the combustion chamber.
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Figure 8.1:  Components of direct-injection two-stroke engine simulation project

The FORTE_2stroke.ftsim project file has been preconfigured with all the information that will be dis-
cussed in this section. You do not need to input any values but can just follow along, reading the in-
structions and viewing the settings in the loaded  .ftsim . This chapter nevertheless explains step-by-
step the process of setting up the project, as an illustration of the features in the user interface.

Open the project file, FORTE_2stroke.ftsim, from the location where you stored the downloaded tu-
torial files.

In this tutorial, we will import an existing geometry into ANSYS Forte and set up the automatic mesh
generation using a global mesh size and adapting the mesh near the valves. To import the geometry,
go to the Workflow tree and click Geometry. This opens the Geometry icon bar. Click the Import
Geometry

icon. In the resulting dialog, pull down and select Surfaces from STL file. In the dialog that opens with
STL file import options, accept the defaults.

The mesh will be automatically generated during the simulations. When the file browser launches,
navigate to the folder Tutorial_2stroke, then select FORTE-2stroke.stl. Note that once you have imported
the geometry, there are a number of actions that you can perform on the items in the Geometry node,
such as scale, rename, transform, invert normals, or delete geometry elements.

The Geometry imports in an opaque mode and possibly preset zoom level. It is often helpful to Refit

the view or use the mouse wheel to re-zoom. To change opacity, right-click the Geometry node in the
right-side Visibility tree and select Medium for the Opacity level of all geometry elements, as shown in
Figure 8.2: Two-stroke geometry after import (p. 92).
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Figure 8.2: Two-stroke geometry after import

8.2.1.1. Two-Stroke Engine Details

A simple engine configuration is used in this tutorial for demonstration purposes. The details of the
configuration and simulation settings are presented here.

Table 8.1:  Details of the diesel engine geometry used in this tutorial

UnitsValueItem

2-stokeCycle type

Direct injection, hollow coreFuel injection system

12.65Compression ratio

cm8.58Bore

cm6.73Stroke

cm13.97Squish

GasolineFuel

The mesh is created using the Automated Mesh Generator in ANSYS Forte. The values described in ????
can be accessed from the  FORTE_2stroke.ftsim project file. If you did not already have a pre-configured
geometry, you could import a Fluent Mesh file, STL, KIVA-3V, or CGNS geometry file. Fluent Mesh files
are the preferred format for importing geometry because they are guaranteed to be water-tight. The
Fluent Mesh file can be created as a surface mesh for the geometry in ANSYS Meshing.

8.2.1.2. Automatic Mesh Generation Setup

Material Point: On this panel, we must set the point that defines where ANSYS Forte will mesh. This
point, the Material Point, must always lie inside the geometry during the entire cycle and should be
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located at least one unit cell length away from any boundaries. On the Material Point Editor panel,
define the point’s location as X = 0.0, Y = 0.0, Z = 6.9 cm.

Global Mesh Size: Set the Global Mesh Size to 2.0 mm. Other Mesh Controls should be set to these
values:

Table 8.2:  Settings for Mesh Control refinements

Crank angle
active range

Refinement
layers

Refinement
level

Refinement
location

Refinement
type

Item

1/2All walls except
inlets and
outlet

Surface
Refinement

AllSurfaces

2 layers1/2Inlets and
Outlet

Surface
Refinement

OpenBoundar-
ies

350° - 370°2 layers1/4Head and
Piston Top

Surface
Refinement

TDC

21/2Intake and
Exhaust Port

Surface
Refinement

PortWalls2

274° - 400°1/2(0.0, 0.0,
6.0) cm

PointCombustion

Radius of
4.4 cm

1/2Feature
angle =60°

FeatureCoarse Fea-
ture

Feature
Radius of
application
=7.0 mm

Intake/Exhaust
Port,
Liner,
Piston
Skirt,
Piston Top

1/4Feature
angle =60°

FeatureFine Feature

Feature
radius of
application
=2.0 mm

Liner,
Piston
Skirt,
Piston Top
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8.2.2. Chemistry Set Details

Chemistry: Now that the mesh has been set up, assigning models is next. Assign the chemistry using
Models ¬ Chemistry and use the Import Chemistry

icon and select the file Gasoline_1comp_59sp.cks from the ANSYS Forte data directory. If you are
curious, you can view the chemistry details, such as chemistry source, pre-processing log, gas phase
input, gas phase output, thermodynamic input, transport input, and transport output.

Flame Speed Model: On the Workflow tree, use Models ¬ Chemistry ¬ Flame Speed Model and select
the Table Library Option. Select Create New, then add ic8h18 as the fuel species and specify iso_octane
as the name. Click Save. Close the Library Editor panel. For the Turbulent Flame Speed settings, keep
the defaults. Click Apply.

8.2.3. Transport Property Settings

The default values are used in the Transport property panel. In the Transport ¬ Turbulence panel, the
RNG k-epsilon model is used, with default values.

8.2.4. Spray Model Settings

Models ¬ Spray Model: Since this is a direct-injection case, turn ON (check) Spray Model in the Workflow
tree to display its icon bar (action bar) in the Editor panel. In the panel, keep the defaults. Leave the
Use Vaporization Model (default) check ON.

Add an Injector: The icon bar provides two spray-injector options: Hollow Cone or Solid Cone. For this

injector, click the Hollow Cone  icon. In the dialog that opens, name the new hollow-cone injector
as Hollow Cone Injector. This opens another icon bar and Editor panel for the new hollow-cone injector.
In the Workflow tree under the Hollow Cone Injector node, add a Nozzle and an Injection. You can
either right-click the Hollow Cone Injector node and select Add or select that Workflow tree item or
use the icons in the panel’s action bar.

On the Hollow Cone Injector panel, create a new Composition, select ic8h18 (iso-octane) in the Species
list, specify the physical properties as iso-octane, and specify the Mass Fraction as 1.0. Use iso-octane
for the Vaporization properties and name the Composition gasoline. Click Save.

For the injection, specify the following parameters:

Table 8.3:  Injection settings used in this tutorial

UnitsValueInput

-3000Injected Parcel Count

K363Inflow Droplet Temperature

bar51.7Injection Pressure

-Checked (ON)Inwardly Opening Nozzle

degrees54.0Mean Cone Angle

degrees15.0Liquid Jet Thickness

-Rosin-Rammler DistributionDroplet Size Distribution

-3.5Shape Parameter

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.94

Two-Stroke Engine Simulation



UnitsValueInput

-12.0Breakup Length Model Constant

With the Hollow Cone Injector selected, add a Nozzle to the injector by clicking the New Nozzle

icon. On the Nozzle Editor panel, set the parameters as described in Table 8.4: Nozzle settings used in
this tutorial (p. 95). Click Apply. You can see the nozzle appear at the top of the geometry. (You may
want to make the Geometry non-opaque or change the color of the nozzle itself in the Visibility tree
to make the nozzle easier to see in the interior.)

Table 8.4:  Nozzle settings used in this tutorial

Location

Global originReference Frame

CartesianCoordinate system

0.0 cmX

0.0 cmY

9.221 cmZ

Spray Direction

Global originReference Frame

SphericalCoordinate System

180 degreesΘ

0.0 degreesΦ

Nozzle Size

0.001647 cm2Nozzle Area

Injection: On the Injection panel, specify the Start of Injection as 275 degrees, the Duration of Injec-
tion as 12.42 degrees, specify the Velocity Profile as a Square Profile, and the Injected Mass as
0.007292 g.

Spark Ignition: Turn on the spark ignition model by checking the box at Models ¬ Spark Ignition. Keep
the defaults for the Spark Ignition settings.

Use the New Spark

icon to create a new spark event and name it Spark.

Use Models ¬ Spark Ignition ¬ Spark to set up the details of the spark event. In the Location, for Refer-
ence Frame, use Global Origin and Cartesian coordinates for the Location, and set X= 1.233 cm,
Y=0.0 cm, and Z=7.76 cm. Select Crank Angle for Timing and Starting Angle = 319.0 degrees, Dur-
ation = 9.0 degrees. Under Spark Energy, set Energy Release Rate = 25.0 J/sec. Accept the default
0.5 for Energy Transfer Efficiency and 0.5 mm (note that the unit is mm) for Initial Kernel Radius.
Click Apply.
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8.2.5. Boundary Conditions

Boundary conditions specify inlets, outlets, and walls. Once you create one boundary condition, you
can copy and paste it (using the Copy

and Paste

icons on the icon bar in the Editor panel), then modify it to create a second boundary condition. Select

a boundary surface, either from the list in the workflow tree or using the Select from Screen  tool
to pick a surface in the 3-D View to associate with a boundary condition.

Inlet: From the Boundary Conditions node, in the Editor panel, click the New Inlet  icon and create
an Inlet named Inlet1. At the top of the Editor panel, select Create New... for the Composition. Click
the Add Species button and then select o2 (oxygen) and n2 (nitrogen) as the species. Specify Mass
Fraction of 0.23 for o2 and 0.77 for n2, as shown in Figure 8.3: Composition editor specifying inlet Air
mixture (p. 96). Name the composition Air and click Save then Close.

Figure 8.3:  Composition editor specifying inlet Air mixture

In the Editor panel, select inlet1 from the Location list. Select Total Pressure, Time Varying as the
Inlet Option. For the pressure profile, select Create New and import the pressure profile using the
Load CSV option. The name of the pressure profile is intake_pressure_profile.csv. On the Load CSV
dialog, clear (deselect) the Read Column Titles option (because the file does not contain any column
titles), as shown in Figure 8.4: Import CSV data for pressure profile (p. 97). The unit for Column 1 should
be Angle and degrees and for Column 2 the units should be Pressure and bar.
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Figure 8.4:  Import CSV data for pressure profile

The pressure profile should look like the profile shown in Figure 8.5: Importing the intake pressure
profile (p. 97).

Figure 8.5:  Importing the intake pressure profile

Define Turbulence using values for Turbulent Kinetic Energy and Length Scale of 3,600 cm2/sec2
and 1.0 cm, respectively. On the Editor panel, accept Assume Isentropic for the Temperature Value
Type. Click Apply.
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Now that the first inlet has been created, copy and paste inlet1 and name it inlet2 using the Copy

and Paste.

icons. Repeat this step to create inlet3. Update the Location to inlet2 and inlet3, respectively, for each
new boundary condition, inlet2 and inlet3.

Outlet: From the Boundary Conditions node, go to the Editor panel and click the New Outlet  icon
and create Outlet. Select Total Pressure, Time Varying as the Outlet Option. For the pressure profile,
select Create New and import the pressure profile using the Load CSV option. The name of the pressure
profile is exhaust_pressure_profile.csv. On the Load CSV dialog, deselect the Read Column Titles
option, because the file does not contain any column titles. The unit for Column 1 should be Angle
and degrees, and for Column 2 the units should be Pressure and bar. Set the Turbulence Boundary
Conditions to Turbulent Kinetic Energy and Length Scale of 3600 cm2/sec2 and 1 cm, respectively.

Piston: From the Boundary Conditions node, go to the Editor panel and click the New Wall  icon
and name it Piston_Moving. Select the piston_top item in the Location list. Set the Temperature
Option to Constant and 450 K. Turn ON the Wall Motion option and set the piston Motion Type to
use a Slider-Crank with a Stroke of 6.73 cm and a Connecting Rod Length of 13.97 cm with 0.0
Piston Offset. To set the axis for translation, under Direction, the Reference Frame is Global Origin
and the Coordinate System is Cartesian. Set X=0.0 cm, Y=0.0 cm, Z=1.0 cm. Change the Movement
Type to Sliding Interface and select the liner and piston_skirt from the list of surfaces. For this setting,
the moving piston should be selected along with the surface it is sliding/moving past.

Note

The RPM is specified on the Simulation Controls Editor panel.

Intake: Click the New Wall  icon and name it IntakePort. Select the intake_port item in the Location
list and turn ON the Heat Transfer option and set the Temperature to 300 K.

Now reproduce the Intake Port with Copy

and Paste

four times to create four new boundaries as detailed in the following table.

Table 8.5:  Details of boundaries created from Copy and Paste operations

Boundary ConditionLocationBoundary NameItem

Wall Model=Law of
the Wall

exhaust_portExhaustPort1

Twall=490 K

Heat Transfer=ON
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Boundary ConditionLocationBoundary NameItem

Wall Model=Law of
the Wall

cylinder_bottom

liner

Liner2

Twall=400 K

Heat Transfer=ON

Wall Model=Law of
the Wall

dome

head

Head3

Twall=400 K

Heat Transfer=ON

Wall Model=Law of
the Wall

piston_bottom

piston_skirt

Piston_Anchored4

Twall=450 K

Heat Transfer=ON

8.2.6. Initial Conditions

The domain is initialized with the operating conditions, species concentrations and temperatures. The
Default Initialization species composition is at the expected exhaust composition, assuming complete
combustion. The intake and exhaust must also be initialized to the boundary condition values. Set the
initialization parameters as described in the following sections.

Initialization Order: When looking at the piston in the TDC position, each isolated region should have
an initialization region with a material point specified, which is typically the combustion chamber, the
exhaust port, and the intake port. In many cases, there will be multiple intake regions that will require
their own initialization, as in this case.

For 2-stroke engine cases, the combustion chamber should have an initialization order of 1. The intake
ports should then have initialization orders of 2, 3, and 4, respectively. Lastly, the exhaust port would
have an initialization order of 5.

Default Initialization:

• Select Default Initialization in the Workflow tree. In the Editor panel, set the Initialization Order to 1. (For
2-stroke engines, the combustion chamber should have an Initialization Order of 1.) Select Create New

in the Composition drop-down list and click the Pencil  icon. This opens the Gas Mixture panel, where
you select Add Species. Set a Mass Fraction of o2=0.1123911, n2=0.7421674, co2=0.0996009, and
h2o=0.0458404, and Save this composition as Exhaust_Est. On the Editor panel, set a Constant Temper-
ature of 1,220 K and a Constant Pressure of 2.7 bar.

• The Turbulence initialization uses the Constant option and the Turbulent Kinetic Energy and Length
Scale option with values 3,600 cm2/sec2 and 1.0 cm, respectively.

• The Velocity is initialized by usingConstant Velocity and selecting Velocity Components and accepting
defaults.

• Click Apply.
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Intake Initialization: The intake Initial Condition is set to match the Boundary Condition at the Inlet.
Since this is a separate port that can be closed off from the main cylinder region, we also need to set
the equivalent of a material point to identify the region, as well as an initialization order that helps
determine what region takes precedence in initializing new cells that appear when gaps are opened.

• From the Initial Conditions Editor panel, select the New Secondary Region From Material Point

icon and name it Intake1.

• To identify the region, select a point for the Location under the Reference Frame = Global Origin selection,
which is a point that will always be within the Intake1 port. Set the Cartesian and the coordinates to X=0.0,
Y=6.0, Z=1.2 cm, which is a point just inside the inlet.

• Set the Initialization Order to 2. Initialization order follows flow order.

• Set the Composition by selecting in the previously saved profile, Air. Set the Temperature to Constant
and 300 K and Pressure to Constant and 1.013 bar. The Turbulence initialization is Constant and uses
the Turbulent Kinetic Energy and Length Scale option set to 3,600 cm2/sec2 and 1.0 cm, respectively.
The Velocity is initialized by using Constant Velocity and Velocity Components and accepting defaults.
Click Apply.

• Copy

and Paste

Intake1 twice, naming the new initializations Intake2 and Intake3. All the settings are the same, except
for the Initialization Order and Location:

Initialization OrderCoordinatesIntake
#

3X= -4.8, Y=0.0, Z= -1.0 cmIntake2

4X=0.0, Y= -5.0, Z=1.2 cmIntake3

Exhaust Initialization: The Initial Conditions of the Exhaust are set to match the Boundary Condition
of the Outlet.

• From the Initial Conditions panel, select the New Secondary Region from Material Point

icon and name it ExhaustPort.

• To identify the region, select a point for the Location under the Reference Frame selection, which is a point
that will always be within the ExhaustPort region. Set the coordinates for this case to X=6.0, Y=0.0, Z=1.4
cm.

• Set the Initialization Order to 5. Flow is expected to go from the cylinder to the exhaust port; for this
reason, we give it the last order in initialization precedence for the 5 regions defined.

• Set the Composition to Constant and the existing profile, Exhaust_Est. Set the Temperature to 490 K
and Pressure to a Constant 0.981 bar.
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• The Turbulence initialization uses a Constant Turbulent Kinetic Energy and Length Scale option; these
are set to 3,600 cm2/sec2 and 1.0 cm, respectively. Click Apply.

• The Velocity is initialized using Constant Velocity and selecting Velocity Components and accepting
defaults. Click Apply.

8.2.7. Simulation Controls

Simulation controls allow you to define the simulation limits, RPM, time step, chemistry solver, and
transport terms.

Simulation Limits: ANSYS Forte uses adaptive time stepping, with user-specified initial time step and
maximum time step. Use Crank Angle-based limits, the simulation Start Crank Angle (i.e., Initial Crank
Angle, under Simulation Controls in the Workflow tree) is set to 97.0 degrees ATDC, and the simulation
Final Simulation Crank Angle is set to +455 degrees ATDC. Set RPM to 2,000.0 rpm and Cycle Type
to 2-Stroke.

Time Step: ANSYS Forte uses adaptive time stepping, with user-specified initial time step and maximum
time step. Use Simulation Controls ¬ Time Step and accept the defaults except:

• Set the Max. Time Step Option to Time Varying, and set up a profile to control the variation in time steps.
This allows the maximum time step to be reduced at times of high interest, such as the spark and injection,
and decreased during other intervals. In the drop-down list for Max Time Step Profile, select Create New

and click the Pencil  icon. Because this is a 2-stroke engine, the simulation should run from 0 to 360 CA
degrees. After setting the following parameters, click Save.

Column 2Column 1

Units = Time and secUnits = Angle and de-
grees

1.00E-50.0

1.00E-5215.0

5.00E-6216.0

5.00E-6360.0

Name of profile: TimeSteps

The Editor panel for creating the profile will resemble Figure 8.6: TimeSteps profile for Max Time Step
Profile (p. 102).
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Figure 8.6: TimeSteps profile for Max Time Step Profile

Chemistry Solver: Simulation Controls ¬ Chemistry Solver is also kept at the defaults for the following
solver tolerances:

Do not activateDynamic Adaptive Chemistry. DAC should not be used for this case since there are
fewer than 500 species. For cases with 500+ species, DAC may provide additional speedup in the simu-
lation.

• Use Dynamic Cell Clustering to take advantage of groups of cells with similar conditions. Select 2 features
to introduce Dynamic Cell Clustering: 1) Max. Temperature Dispersion of 10 K and 2) a Max. Equilibrium
Ratio Dispersion of 0.05.

• To increase the time-to-solution speed, you have the ability to choose when chemistry is activated. In this
tutorial, select Activate Chemistry Conditionally, turn ON (check) After Fuel Injection Starts, and select
When Temperature is Reached with Threshold Temperature = 600 K. This ensures that chemistry is active
during the time that combustion is expected. Click Apply.

8.2.8. Output Controls

Output controls determine what data are stored for viewing during the simulation and for creating
plots, graphs, and animations in ANSYS Forte Visualize, CFD-Post, EnSight, or FieldView.

The following species are named in both the Spatially Resolved and Spatially Averaged and Spray
Output Control Editor panels, to be written to the results file. Fuel, oxidizer, and common emissions
species are automatically added. Move these species into the Selection list.

• n2

• o2

• co2

• h2o
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• co

• no

• no2

• ic8h18

The spatially resolved values are output at intervals of 5 crank angles, and the spatially averaged values
every 1.0 crank angle. On each of the panels, click Apply.

Output Controls ¬ Spatially Resolved: On this Editor panel, you can also optionally increase the fre-
quency of output during the cycle by selecting User Defined Output Control and importing the out-
put_crank_angles.csv file, which has a list of specific crank angles where spatially resolved output will
occur. Specify the name of the profile as output _crank_angles. Alternatively, you could select User
Defined Output Control, and use the Profile Editor to create the same profile, or some other file spe-
cifying an output crank-angle profile (the provided profile is illustrated inFigure 8.7: Output CAs profile
for Spatially Resolved output (p. 103) ). Click Save once the profile is imported and the name is specified.

Output Controls ¬ Spatially Averaged: This Editor panel allows you to control the output of values
that are averaged across the domain. Keep the default species and solution variables selected for output.
Reducing the variables selected will help reduce file sizes.

Figure 8.7:  Output CAs profile for Spatially Resolved output

Restart Data: If you anticipate that the case will be stopped and you want the ability to restart it from
the last time step solved, select Output Controls ¬ Restart Data. You can specify certain Restart Points
using a separate file. Turn ON (checkmark) User Defined Restart Points and use the Profile Editor to
create a Restart profile. You can view, edit, or import new Restart Points in this 1-D Profile Editor.
Sometimes it is helpful in spark ignition cases to save a restart file after IVC but before the spark occurs
(CA=687 in this case) so you can use the compression portion of the cycle as a start point in additional
runs. Create a new profile for this purpose called Restart_crank_angles and add the lines with CA
value set to 274.0, 318.0, 400.0 CA degrees. Click Save.
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8.2.9. Preview Simulation

You can view the profiles for accurate boundary motion and appropriate mesh quality with the Preview
Simulation options.

Boundary Motion: Preview boundary motion with the player buttons on the Boundary Motion Editor
panel or by right-clicking the Boundary Motion item in the Workflow tree and selecting a command.
During the preview, a dotted line tracker provides a representation of the piston translation and the
location of the injection and spark events (in the Editor panel), and the piston’s motion (in the 3-D View
if visibility settings are appropriate).

Preview Mesh: As a method for checking the automatically generated mesh, you can generate a Preview

Mesh. Select Preview Simulation ¬ Mesh Generation and then click the New Automatic Mesh Plot
icon, name this new automatic mesh generation plot Start, select Crank Angle as the Time Option
and set it to 98.0 CA. Then click Apply.

Copy

and Paste

the Start mesh twice. Name the first copy Open with Start = 127.0 degrees and X, Y, Z = 0.0 cm.
Name the third mesh TDC with Start = 360.0 degrees and X, Y, Z = 0.0 cm. Now for each of the three

meshes in turn, click the Generate Mesh  icon. ANSYS Forte will generate the preview mesh and
display it in the 3-D View window. It is a good practice to look at meshes at key points in the cycle such
as Firing Top Dead Center (FTDC), Exhaust Valve Opening (EVO), Intake Valve Closed (IVC), Intake Valve
Open (IVO) and Exhaust Valve Closed (EVC).

If you want to see the cut plane where the mesh will be generated, click the Plane Filter box and
specify an origin point and normal direction for the cut plane. This adjustment has been added to the
three meshes in this example. To create a cut plane, on each Mesh Generation Editor panel, turn ON
(check mark) the Plane Filter box, and set the values as specified in Table 8.6: Specifications for Cut
Planes in Mesh Preview Editor panels (p. 104)

Table 8.6:  Specifications for Cut Planes in Mesh Preview Editor panels

TDC meshOpen meshStart mesh

Setting for Mesh Preview

360.0127.098.0Start (CA degrees)

Settings for Cut Plane

X=-0.0, Y=0.0, Z=0.0X=-0.0, Y=0.0, Z=0.0X=-0.0, Y=0.0-2.3, Z=0.0Plane Filter >
Point > Ref. Frame
> Global Origin >
Cartesian

 

X=-0.0, Y=1.0, Z=0.0X=-0.0, Y=1.0, Z=0.0X=-0.0, Y=1.0, Z=0.0Plane Filter >
Normal > Ref.
Frame > Global
Origin > Cartesian
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The faces for the mesh have been hidden such that only the mesh lines are shown. Also, the boundary
condition and geometry surfaces have been hidden. Figure 8.8: Preview mesh at 98 CA degrees, the
start of the simulation (p. 105)

Figure 8.8:  Preview mesh at 98 CA degrees, the start of the simulation

8.2.10. Run Settings

The settings here depend on the system and environment for your simulations. The default for the Run
Settings panel is to have nothing selected.

Run Options: This tutorial does not require changes to this panel’s defaults; adjust them as necessary
for your environment.

Windows Settings: This tutorial does not require changes to this panel’s defaults; adjust them as ne-
cessary for your environment.

Linux Settings: This tutorial does not require changes to this panel’s defaults; adjust them as necessary
for your environment.

8.2.11. Run Simulation

The last step is to submit the simulation to the solver or prepare for submission on a cluster.
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To complete the lesson, select Run Simulation on the Workflow tree and, once ANSYS Forte displays
the green Start button on the Run Simulation panel and reports a “Ready” status, click Start. You can

monitor the results by clicking on the Monitor Runs  icon. In the Monitor window that opens, you
can select the run you want to monitor. The pressure trace should look like the one in Figure 8.9: Mon-
itoring the pressure from Run Simulation (p. 106). This simulation takes about 11 hours to complete on
20 cores (Intel® Xeon® E5-2690 @2.9GHz).

Figure 8.9:  Monitoring the pressure from Run Simulation

8.3. Project Results

To view the results of the simulation, open the results in CFD-Post. In CFD-Post, open the solution file
for the case (Nominal.ftind). Figure 8.10: Screen view of the solution file in CFD-Post (p. 107) shows the
screen view once the solution file has been loaded.
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Figure 8.10:  Screen view of the solution file in CFD-Post

Once you have read in the model, you can create surface groups to group the surfaces. In this case, we
will create a surface group for the spark plug, walls, symmetry boundaries, and the valves. To create a
surface group, right-click User Locations and Plots Insert > Locations > Surface Group and specify
the name surfaces. On the Color and Render tab, you can change the color of the surfaces and the
transparency. In Figure 8.10: Screen view of the solution file in CFD-Post (p. 107), the surfaces are colored
gray and the transparency is set to a value of 0.5.

To visualize the solution in the combustion chamber, create a cut plane by right-clicking User Locations
and Plots > Insert > Location > Plane. Specify the Method as a ZX plane. On the Color tab, set the
Mode to Variable and specify the Variable as Temperature, click Apply. The temperature is now dis-
played on the cut plane, as shown in Figure 8.11: Temperature contour plot on a plane through the
centerline of the combusiton chamber (p. 108).
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Figure 8.11: Temperature contour plot on a plane through the centerline of the combusiton
chamber

To visualize the spray injection into the chamber, activate the Spray option. Double-click Spray to edit
the settings. On the Color tab, set Mode to Variable and select Spray Particle Radius. Set the Range
to Local. To visualize the spray at a specific crank angle, go to Tools > Timestep Selector. In this case,
crank angle 291.02 is specified.
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Figure 8.12:  Spray particles in the chamber at 291 CA degrees

Finally, to visualize the position of the flame, we need to create an iso-surface. To create the iso-surface,
right-click User Locations and Plots and select Insert > Location > Isosurface. Specify flame as the
name of the surface. Specify G as the variable and specify red as the color for the surface on the Color
tab. To see the flame location, we must specify a crank angle after spark timing. Spark timing in this
case is 319CA degrees, so you can use the menu command Tools > Timestep Selector to select a crank
angle after spark timing.
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Figure 8.13:  Isosurface at 334 CA degrees showing the location of the flame front
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Chapter 9: Multi-Cylinder Four-Stroke Engine Simulation

This tutorial describes how to use ANSYS Forte CFD to simulate engine processes in an inline four-cyl-
inder four-stroke spark-ignition engine. The purpose of this tutorial is to demonstrate several key points
of project setup that are specific to multi-cylinder use cases:

• Use (spatial) Reference Frames to facilitate the setup of location and orientation parameters in each cylinder.

• Use Time Frames to facilitate the setup of timing parameters in each cylinder.

• Approximate initial conditions in each cylinder region for a given starting crank angle.

• Monitor output parameters that are averaged for each cylinder region.

Although the example used is an inline four-cylinder four-stroke spark-ignition engine, the concept and
methodology described in this tutorial are also applicable to other multi-cylinder configurations, such
as V-shaped arrangement, opposed piston engines, as well as other types of engine operations, such
as spray combustion in diesel engines, HCCI, etc.

This tutorial is based on a fully configured Forte project (.ftsim) file. The steps described only highlight
the key points specific to multi-cylinder engines and are not intended to explain all the entire detailed
setup. The tutorial assumes that learner is already familiar with the fundamental steps for setting up a
single-cylinder engine in Forte. Such prerequisite knowledge can be obtained by studying tutorials in
previous chapters, such as the ANSYS Forte GDI tutorial,Solving a Gasoline Direct Injection Engine
Simulation (p. 67).

9.1. Data Provided

9.1.1. Accessing Tutorial Files

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training. There, select the Forte tutorials and the desired files to download.

After downloading, you have the opportunity to select the location for the files when you download
and unzip the sample files.

9.1.2. Files Used in This Tutorial

The files for this tutorial include:

• multicylinder_4stroke_engine_tutorial.ftsim: A completely configured ANSYS Forte project file.

• intake_valve_lift_profile.csv: Lift profiles of the intake valves, tabulated for the crank angle range of [0,
720] °CA ATDC.

• exhaust_valve_lift_profile.csv: Lift profiles of the exhaust valves, tabulated for the crank angle range of
[0, 720] °CA ATDC.
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• multicylinder_4stroke_engine_tutorial.stl: An STL file that contains the multi-cylinder geometry. This is
an optional file, which could be used as part of an exercise setting up this Forte project without using pre-
configured files.

9.2. Engine Configuration and Problem Description

The configuration of the inline four-cylinder engine is shown in Figure 9.1: Configuration of the inline
four-stroke multi-cylinder engine (p. 112). The figure shows the numbering of the four cylinders, the intake
manifolds merging at a plenum, the inlet located on the side of the plenum, as well as two groups of
exhaust manifolds. One group of exhaust manifolds is connected to Cylinder-1 and Cylinder-4, the
other is connected to Cylinder-2 and Cylinder-3. In this geometry, the crank shaft axis of the engine
(not shown) is parallel to the Z-axis and the cylinder axes are parallel to the Y-axis. If you prefer, you
can rotate the geometry so the cylinder axes are parallel to the z-axis. To do the rotation, select all the
geometry surfaces under Geometry, right-click, select Transform Mesh, and then select Rotate X by
90 degrees. The setup steps described below are based on the original orientation, not a transformed
geometry. The engine geometry will serve as the surface mesh for the automatic mesh generation.
Automatic Mesh Generation requires that all the pistons are positioned at their top-dead-center (TDC)
location and all valves are at their closed location in the initial surface mesh.

There is one spark per cylinder central-mounted near the top of each cylinder head. The firing order of
this engine is 1-3-4-2, which means that there is a 180 °CA phase delay between any two consecutive
spark events.

In this tutorial, the fuel/air mixture preparation process inside the intake manifolds is simplified and no
port fuel injection is simulated. Instead, the fuel and air are treated as premixed stoichiometric mixture,
which enters the computational domain through the inlet connected to the plenum.

Figure 9.1:  Configuration of the inline four-stroke multi-cylinder engine
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9.3. Multi-Cylinder Spark-Ignition Engine Project Setup

This section will go over the simulation setup steps, with emphasis on several aspects that are specific
to multi-cylinder simulation.

Note

Time frames can be added under Geometry > Time Frames. However, the default state for
the Time Frames node in the Workflow tree is hidden. To see it, use the Preferences com-
mand in the Edit menu and check Enable Reference Time Frame Controls. Then Exit and
restart ANSYS Forte.

9.3.1. Geometry Import

(Optional) If you wish to set up the case without using the preconfigured files, you can start with im-

porting the supplied STL geometry file. On the Geometry Editor panel, click the Import Geometry
icon, and choose the Surface from one or more STL files option, and then browse for the STL file.
This step is needed only if you want the exercise of setting up the case from scratch. These steps are
not detailed here.

9.3.2. Defining Reference Frames and Time Frames

Reference frames and time frames in ANSYS Forte allow you to define transforms to apply in space and
time.

9.3.2.1. Reference Frames

Reference frames used in ANSYS Forte are spatially transformed coordinate systems. They can be defined
in the Workflow tree under Geometry > Reference Frames. A new reference frame can be defined by
referring to its parent coordinate system and through transformation of either or both the origin and
orientation. In a multi-cylinder geometry, by defining equivalent local reference frames for all cylinders,
you can use the same set of location and orientation parameters for all cylinders.

To make it convenient to set up equivalent local coordinate systems for all the cylinders, the geometry
must meet some basic requirements relating to alignment with the coordinate axes in the global co-
ordinate system. Generally, the minimum requirement is to let the crank shaft axis be parallel to one
of the coordinate axes in the global coordinate. This tutorial case satisfies this requirement because its
crank shaft axis is parallel to the Z-axis.

Now let us define a local reference frame for each cylinder. There are no fixed rules for setting the origin
of each cylinder’s own reference frame, but a convenient way is to use the center of the piston as the
local origin. Using Cylinder-1 as an example, under Geometry, click surface piston_1. The piston_1
Editor panel shows the Min and Max coordinate values along X-, Y-, Z-directions in the global reference
frame. The center of piston_1 on the X-Z plane can be calculated as

X_center = 0.5*(X_min + X_max) = 0.5*(-3.949 + 3.948) = 0 cm

Z_center = 0.5*(Z_min + Z_max) = 0.5* (31.15 + 39.05) = 35.1 cm

Since Y_min and Y_max are the same, you can pick Y_min as Y_center. In this specific example, it is
beneficial to let all four cylinders have the same Y_center value.
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In the fully configured .ftsim file, you can see four Reference Frames for the four cylinders: Frame-
C1, Frame-C2, Frame-C3, and Frame-C4, listed in the Workflow tree. Their origins are calculated based
on the method described above and the values are listed in Table 9.1: Origins of local reference frames
for four cylinders (p. 114). We can see that the distance along the Z-direction between the axes of two
consecutive cylinders is 9.5 cm. These four reference frames do not involve orientation transformation.
Orientation transformation is needed in a V-type multi-cylinder engine.

Table 9.1:  Origins of local reference frames for four cylinders

Frame-C4Frame-C3Frame-C2Frame-C1(cm)

0000Origin X

19.719.719.719.7Origin Y

6.616.125.635.1Origin Z

In this tutorial engine, all the intake valves are tilted on the X-Y plane by -11° relative to the Y-axis, and
all the exhaust valves are tilted in a similar manner, but by 12°.The tilt angles are illustrated in Fig-
ure 9.2: Tilt angles of intake and exhaust valve stems (p. 114). Two reference frames are created for intake
valves and exhaust valves, respectively, such that the Y-axes of these two reference frames are aligned
with the moving directions of the valves. The names are Frame_Intake_Valves_Dir and
Flame_Exhaust_Valves_Dir. The transformation only involves rotation about the Z-axis. These
two reference frames can be used to define the moving directions of the valves. They can also be used
to adjust the valve gaps at seated position if needed.

Figure 9.2: Tilt angles of intake and exhaust valve stems

9.3.2.2. Time Frames

Note

If you cannot see Time Frames listed under Geometry in the Workflow tree, edit your Pref-
erences as described in the note in Note (p. 113) early in this tutorial.

Time frames are convenient tools for managing all the timing parameters in a multi-cylinder context.
A time frame requires input of a crank angle offset. An event associated with the time frame will be
delayed by the offset value relative to the global crank angle. By defining an appropriate time frame
for each cylinder, you can use the same set of timing parameters for all the cylinders in the configuration.
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Such timing parameters include, for example, piston motion specification and valve lift profiles, spark
timing, and injection timing.

The Global Time is a prepopulated item, which corresponds to the global crank angle and serves as a
reference. It cannot be edited. You can add four new time frames, one for each cylinder. Since the firing
order of this engine is 1-3-4-2, the crank angle offset values can be set as 0 °CA, 180 °CA, 360 °CA,
540 °CA for Cylinder 1, 3, 4, 2, respectively. Note that Cylinder-1 is essentially associated with the
global crank angle, and therefore it is used as a reference cylinder.

9.3.3. Automatic Mesh Generation Setup

A multi-cylinder case requires that one of the cylinders be defined as the reference cylinder and associated
with the Default Initialization region under Initial Conditions. The Material Point under Mesh Controls
is expected to be a location inside the Default Initialization region. Since Cylinder-1 is assigned as
the reference cylinder in this tutorial, the material point should be inside Cylinder-1. As mentioned
earlier, since the origin of the reference frame for Cylinder-1 is defined as the center of the piston
surface at the piston’s TDC position, you can set the material point a distance above the local origin.
The location selected should be able to remain inside the combustion chamber at all times while the
piston travels from its BDC to TDC and the valves move from a fully closed position to a fully lifted
position. In this sample, the Material Point is set to (X, Y, Z) = (0.0, 1.0, 0.0) cm in the Frame-C1 ref-
erence frame. The Global Mesh Size is set to 4.0 mm.

Several refinement controls for surface or volume are used to obtain higher mesh resolution at system
boundaries and at various locations that are expected to see high gradients for velocity or temperature.

You can go through the refinement control items under Mesh Controls in the fully configured project
file to check their detailed specifications.

Under Mesh Controls on the Workflow tree, AllWalls, OpenBoundaries, ValveStems, Chamber_BL,
and ValveSeats are surface refinement controls that are applied at all times. ValveSeats specifies a 1/8
refinement for all valve seat surfaces in all the cylinders. In a typical engine geometry, cells near the
valve gaps must be sufficiently refined (approximately 0.5 mm) to ensure that the computational domain
of the intake/exhaust manifolds and the cylinders are cleanly separated when the corresponding valves
are closed.

IVO_n and EVO_n, in which n is a numeral, are interval-based surface refinements applied to the
combustion chamber walls during intake-valve opening or exhaust-valve opening processes. The cylinder-
specific time frames are convenient when setting up these crank-angle-interval–based controls. By as-
sociating such a control with a cylinder’s local time frame, you can specify the start angle and end angle
values with respect to the cylinder’s local TDC, and the same crank angle values can be used for all the
cylinders. For example, the crank angle interval for refinement controls IVO_1 to IVO_4 has the same
value, [323, 563] °CA ATDC. The only difference for this timing control is the time-frame selection. Note
that the Location should point to the corresponding surfaces in each cylinder.

SparkPlug_1 to SparkPlug_4 are spherical volume refinement controls that specify 1/8 refinement in
a small region surrounding each spark plug. The center of the refinement volume will be set at the
spark location and the Radius of Application is 0.4 cm. By specifying the coordinates of the refinement
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center relative to the origin of each cylinder’s local reference frame, the same center coordinates can
be used for these four controls.

Note

As an option, you can limit this refinement to 10 °CA before spark and 60 °CA degree
after spark in each cylinder.

9.3.4. Model Setup

Chemistry: The single-component 59-species gasoline chemical kinetics mechanism that is included in
Forte’s chemistry mechanism database is used to simulate the combustion of gasoline/air mixture, in
which gasoline is approximated by iso-octane. The chemistry set can be found in the data folder
within the Forte installation. The name of the chemistry set is Gasoline_1comp_59sp.cks.

Flame Speed: The Gülder formulation of the power law will be used to compute laminar flame speeds
in the flame propagation model. For all the other model inputs on the Flame Speed Model panel, the
default values are used.

Spark Ignition: Turn on the spark ignition model by checking the checkbox in front of Spark Ignition
in the Workflow tree. On the Spark Ignition > Settings panel, the checkbox in front of Flame
Propagation Model is checked by default. This means the flame propagation will be modeled using
the discrete particle ignition kernel (DPIK) model and the G-equation model. Keep the default values
for all the model constants.

Sparks: In this engine, each cylinder contains one spark plug. The spark plug structure is included in
the cylinder head surfaces. On the SparkIgnition Editor panel, you can create four spark plug items to
specify their location, spark duration, energy discharge rate, etc. Start with adding the spark plug for

the first cylinder by clicking the Spark  icon on the SparkIgnition Editor panel. By specifying the
spatial reference frame as Frame-C1, the coordinates of the spark plug’s location can be specified with
respect to this cylinder’s local reference frame. The coordinates of the spark gap are (-0.4, 1.35, 0.0)
cm. Similarly, by linking this spark’s timing parameter to Time Frame Cylinder 1, the spark timing value
can be specified with respect to this cylinder’s local TDC. The spark timing is 20°CA before the firing
TDC, so the starting angle of spark is set to 700°CA ATDC. The default values are kept for spark energy
and initial kernel radius. After the first spark, Spark 1, has been configured, you can then duplicate it

(Copy  and Paste ) to create the spark plugs in the other three cylinders. After each copy and
paste, you can simply adjust the Time Frame and (spatial) Reference Frame to their respective local
frames.

Spray: (Optional) This tutorial does not involve spray simulation, but fuel sprays within each cylinder
or within the intake ports of each cylinder could be set up in a similar manner as the spark setup. You
can start with configuring the injector for the reference cylinder, and then duplicate that injector for
the other cylinders. For each duplicated injector, you must adjust the time frame as well as the reference
frames for each nozzle to use the cylinder’s local frames. Note that the time frame is applied on the
Injector level, that is, the injection timings of all the Injection pulses added under an injector are as-
sumed to use the same time frame specified on the Injector Editor panel.

9.3.5. Boundary Conditions

In the context of multi-cylinder engines, the boundary conditions can be divided into two groups, one
is shared by all cylinders and the other is cylinder-specific. The cylinder-specific boundary conditions
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include head, liner, and moving surfaces (pistons and valves). For the cylinder-specific boundary condi-
tions, you can first do the configuration for the reference cylinder, and then duplicate that for the rest
of the cylinders. For each duplicated boundary condition item, the only parameters that must be adjusted
are the Ref. Frames (for locations or directions) and Time Frames (for timings). Of course, the Location
selection should be adjusted accordingly as well.

In this tutorial, boundary conditions shared by all the cylinders include Inlet, Outlet_1, Outlet_2, In-
takeManifold, ExhaustManifold1, and ExhaustManifold2. The first three are open boundaries, which
involve time profiles for boundary pressure and temperature. The time frame associated with these
time profiles should be set to Global Time. In this tutorial, port fuel injection will not be simulated. In-
stead, the mixture coming into the domain through the inlet is assumed to be a premixed stoichiometric
air/fuel mixture.

The boundary conditions head and liner are static wall boundaries. They are cylinder-specific, but do
not require a time frame input, therefore the head surfaces of all cylinders are grouped as one boundary
condition and the same is done for the liner surfaces. If preferred, you can split each group into four
individual boundary condition items. Such a split may be needed if you want to define different wall
boundary temperatures for different cylinders.

Each moving surface requires the specification of a Wall Motion. The wall motion for pistons and valves
in different cylinders can easily be synchronized with the help of the cylinder-specific time frames. In
the fully configured ANSYS Forte project file, Piston_1, IntakeValve1-1, IntakeValve2-1, ExhaustValve1-
1, ExhaustValve2-1 are the moving boundary conditions for Cylinder_1 (the last numeral in the BC
name indicates the cylinder index). If setting up the project on your own, you could first create these
five boundary conditions, specify the Time Frame as Cylinder 1, and specify the Ref. Frame used by
the wall motion direction as Frame-C1. Then, duplicate these BCs for the other cylinders.

For a duplicated piston, adjust three items to reflect the local cylinder:

• Location selection;

• TimeFrame; and

• Ref. Frame (for motion direction).

For a duplicated valve, adjust four items:

• Location selection;

• Time Frame (for lift profiles);

• Ref. Frame (for motion direction); and

• the selection of Valve Seat and the Surface it Contacts.

All the other parameters can be kept the same for different cylinders, including the valve lift profiles.

Note that Frame-C1 to Frame-C4 are used to specify the valve motion direction in the current project
file. An alternative (probably easier) way is to use the Ref. Frames mentioned earlier, Frame_In-
take_Valves_Dir and Flame_Exhaust_Valves_Dir. For example, when using Frame_Intake_Valves_Dir
to specify the moving direction of the intake valves, you can simply specify the Cartesian direction
vector as (X, Y, Z) = (0, -1, 0). The same motion direction setting can be applied to all intake valves be-
cause they all move along the same direction. The same approach can be applied to the exhaust valves.
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9.3.6. Initial Conditions

A multi-cylinder simulation should intrinsically also be a multi-cycle simulation. This is because the cyl-
inders will be in different stages (strokes) of an engine cycle no matter where the simulation starts, and
it will take multiple engine cycles to let the simulation reach a “converged” state starting from approx-
imated initial conditions. Nonetheless, it is beneficial to provide a good estimate for initial conditions
as this can help the simulation approach the “convergence” faster.

According to the lift profiles of the intake and exhaust valves and the minimum valve lift distance, the
intake valves are open in crank angle interval [380, 580] °CA ATDC and the exhaust valves are open in
[172, 380] °CA ATDC in each cylinder’s local time frame. Thus, the firing TDC of this engine is 0°CA ATDC
(or 720°CA ATDC). In this tutorial, we will set the starting crank angle to 0°CA ATDC. The starting angle
is the global crank angle, which is also in sync with the local crank angle in Cylinder-1. At this starting
angle, the piston positions and strokes each cylinder is about to start are listed in Table 9.2: Piston pos-
itions and strokes to begin in each cylinder (p. 118):

Table 9.2:  Piston positions and strokes to begin in each cylinder

Stroke about to startPiston Position

Expansion/WorkFiring TDCCylinder 1

ExhaustBDC (180° after Firing TDC)Cylinder 2

CompressionBDC (180° before Firing TDC)Cylinder 3

IntakeNon-Firing TDCCylinder 4

ANSYS Forte requires that the reference cylinder (Cylinder-1 in this case) be defined as the Default
Initialization region. This default region will use the global material point for mesh creation and thus
does not require a separate material point input. In addition, the Region Type of the Default Initialization
region is assumed to be Cylinder/Primary, and thus it does not require a Region Type input.

Chamber-2, Chamber-3, and Chamber-4 are three new regions for the other three cylinders, and they
are based on material points. By linking these regions to their respective spatial Ref. Frames, the ma-
terial point coordinates can have the same value as the coordinates of the global material point. Note
that the global Material Point under Mesh Controls in the Workflow tree is linked to Ref. Frame
Frame-C1. For these three non-default cylinder regions, the Region Type should be specified as Cylin-
der/Primary. Note that the cylinder numbering will follow the order as they appear on the Workflow
tree under Initial Conditions.

At the starting crank angle, Cylinder-1 is beginning the expansion stroke, the mixture is approximated
as complete combustion products, the temperature and pressure are also approximated as peak values
during combustion, 2000 K and 20 bar, respectively. Cylinder-2 is starting the exhaust stroke, so the
composition is also set to complete combustion products, but the temperature and pressures are lower
than those in Cylinder-1. They are set to 1200 K and 1.5 bar, respectively. Cylinder-3 is starting the
compression stroke. Physically, the mixture inside this cylinder should be a fuel/air mixture mixed with
a small fraction of residual gas. For simplicity, the initial composition is approximated as a stoichiometric
fuel/air mixture. The temperature and pressure in Cylinder-3 should be similar to the values in the intake
manifold. They are set to 340 K and 1 bar, respectively. Cylinder-4 is at the non-firing TDC and starting
the intake stroke, the composition is mainly combustion products. The temperature and pressure are
approximated as 600 K and 1 bar. The default settings are used in the fields for initial turbulence para-
meters and initial velocity.

Intake Port, ExhaustManifold_1, and ExhaustManifold_2 are three regions with Region Type defined
as Other. For Intake Port, the initial composition is approximated as stoichiometric air/fuel mixture.
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Temperature and Pressure are set to 313 K and 1.1 bar, respectively. For the two exhaust ports,
composition is set to combustion products, and Temperature and Pressure are set to 500 K and 1
bar, respectively. The material points can be placed anywhere inside the respective manifold geometry.

The Initialization Order values of all the initialization regions should be set following the “go-with-the-
flow” rule. The order of the intake port should be 1, followed by the four cylinders, and finally the two
exhaust manifolds.

The Composition Calculation Utility contained in the ANSYS Forte Setup Interface can be used to
prepare different mixtures required by the initial conditions.

9.3.7. Simulation Controls

A multi-cylinder engine simulation must use the Crank Angle Based option on the Simulation Controls
Editor panel. The initial and final crank angles exposed on the Simulation Controls panel are both
global values. In the fully configured project, the case is set up to run two complete engine cycles.

On the Time Step Editor panel, the Max Simulation Time Step, dtmax, uses a constant value (1.E-5
s) in the current project. If a time varying dtmax profile is used instead, the profile is required to cover
the crank angle range of [0, 720] °CA ATDC. This profile will be applied to all cylinders within each cyl-
inder’s local time frame. Specifically, a max time step value is first determined in each cylinder separately
based on the profile and the cylinder’s local crank angle value. Then, the minimum value among all the
cylinders will be used as the global Max Simulation Time Step.

For the chemistry activation control on the Chemistry Solver panel, it is recommended not to check
the After First Spark Event and After Fuel Injection Starts boxes because these controls are not well-
defined in the multi-cycle, multi-cylinder context. Instead, you can use the During Crank Angle Interval
option to activate chemistry for a certain duration within an engine cycle. Similar to the Max Simulation
Time Step control, the interval-based chemistry activation control is also assumed to be applied in all
the cylinders based on each cylinder’s local time frame. For example, in this tutorial, the interval is set
to [-40, 100] °CA ATDC. This means chemistry will be activated 40°CA before the Firing TDC and deac-
tivated 100°CA after the Firing TDC in all four cylinders.

9.4. Result Visualization

In a multi-cylinder calculation, cylinder-specific spatially-averaged solutions are reported on a per-cylinder
basis. The cylinder-specific CSV output files include:

• thermos.csv

• dynamic.csv

• flame.csv

• massfraction.csv

• molefraction.csv

• speciesmass.csv

The cylinder index will be appended to the file names to indicate which cylinder they are for. For example,
you will see thermo1.csv, thermo2.csv, etc. These files include both the global crank angle and
the cylinder’s local crank angle. The local crank angles are always converted to values within the range
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of [0, 720) °CA ATDC. For two-stroke engines, the local crank angles will be in the range of [0, 360) °CA
ATDC.

The rest of the CSV files are reported either based on the average over the whole computational domain
or reported on a per-boundary-condition basis, and they have the same format as single-cylinder calcu-
lations.
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